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1 ЗАГАЛЬНІ ПОЛОЖЕННЯ 

 

Метою виконання студентами лабораторних робіт є закріплення ними 

основних положень теорії курсу та набуття практичних навичок щодо ро-

боти із звукотехнічними та радіо-, телемовними системами, пристроями, їх 

вузлами, ознайомлення із методикою цифрового кодування аудіо-, відео-

сигналів (digital encoding of audio- and video signals),  вимірювання основ-

них параметрів цифрових кодеків. 

У процесі лабораторних занять студенти повинні навчитись правильно 

оцінювати результати досліджень, свідомо встановлювати межі застосу-

вання теоретичних положень і розуміти причини можливих розбіжностей 

результатів експерименту та відповідних положень теорії. 

Перед виконанням роботи викладач перевіряє знання студентів, їх під-

готовку до роботи. Студент повинен: 

- розуміти фізику явищ, що вивчаються у лабораторній роботі; 

-  знати схеми та алгоритми, за допомогою яких виконуються дослі-

дження, і методики проведення експериментів; 

- вміти правильно користуватись вимірювальною апаратурою і ком-

п'ютерним обладнанням; 

- ясно уявляти результати дослідів, які очікуються, вміти їх 

пояснити. 

Лабораторну роботу виконує бригада студентів, що складається, в се-

редньому, з 3–4 чоловік. 

Кожен студент зобов'язаний активно брати участь у проведенні експе-

риментальних досліджень. 

Перш ніж розпочати дослідження, слід перевірити на функціонування  

обладнання, правильно з'єднати вимірювальні прилади з досліджуваним 

обладнанням або лабораторним макетом. Обов'язково слід проконтролю-

вати правильність підключення джерела живлення. 

У випадку виявлення пошкоджень треба звернутись до викладача і під 

його наглядом разом з лаборантом знайти та усунути пошкодження. Скла-

дні пошкодження, що потребують розкриття апаратури, усувають тільки 

працівники лабораторії. 

Попередній протокол результатів досліджень треба вести у спеціально 

заведених з цією метою зошитах і супроводжувати їх відповідними розд-

руківками таблиць, рисунків та графіків. Обов'язково фіксують всі умови 

проведення експериментів (рівні сигналів, перешкод і шумів, частоти і т. 

п.). Треба вказувати типи і заводські номери комп'ютерів, вимірювальних 

приладів та апаратури, що досліджується. 

Після закінчення роботи викладач перевіряє і підписує попередній 

протокол, робить відповідну позначку у своєму журналі. 
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2 ОФОРМЛЕННЯ ЗВІТУ 

 

 

Звіт повинен дозволити спеціалісту у галузі радіотехніки та телекому-

нікацій однозначно уявити зміст та результати здійснених досліджень і 

зробити висновок про ступінь досягнення мети роботи. Цьому сприяє сти-

слість, наочність оформлення текстового і графічного матеріалу, правиль-

на рубрикація, виконання вимог відповідних стандартів, чіткий взаємозв'я-

зок частин і розділів. 

Звіт про виконання лабораторної роботи повинен містити: 

- титульний  лист,  де  вказано  найменування  і  номер роботи, групу, 

прізвища та ініціали студентів і викладача, дату виконання роботи; 

- мету роботи; 

-  перелік обладнання та комп'ютерних програм, за допомогою яких 

проводиться дослідження ; 

- перелік скорочень; 

- виконане домашнє завдання; 

- програму експериментальних досліджень, тобто хід роботи; 

- результати досліджень та їх обробку, таблиці та графіки 

залежностей, що досліджуються (якщо табличні  дані не потребують    

будь-якої обробки і не потрібні для здійснення інших пунктів програми, то 

таблиці можна не наводити); 

-  висновки. 

Усі рисунки, схеми і графіки повинні бути пронумеровані та позначені, 

до якого досліду вони відносяться. Вказують постійні величини, які відо-

бражають початкові умови досліду. На координатні осі наносять масштаб-

ні позначки і вказують розмірності. Для графічного зображення виміряних 

характеристик треба вибирати зручні для порівняння масштаби і розмірно-

сті (якщо це доцільно − у відносному вираженні). У випадку  зміни значень 

в межах 15–20 дБ і більше зручно використати логарифмічний масштаб. 

Графіки залежностей мають бути такими, щоб на них чітко було видно 

точки, одержані під час експерименту. Оскільки є похибки вимірювань, 

зняті точки мають деякий розкид. Тому криві слід проводити між ними, 

опираючись на закономірності явищ, що досліджуються. 

Рубрикація звіту  означає  розбиття  його  на розділи, підрозділи, пунк-

ти. Розділам і підрозділам даються заголовки. Правильна  рубрикація  

спрощує читання і поліпшує розуміння матеріалу звіту, сприяє скорочен-

ню його обсягу, зменшує трудомісткість оформлення. Отже, можна значно 

скоротити текст пунктів розділу "Результати  експериментальних дослі-

джень" і заголовки таблиць, зробивши доречне посилання на відповідний 

пункт розділу "Програма експериментальних досліджень". Аналогічно 

спрощуються написи до рисунків, графіків, формулювання у розділі "Ви-

сновки" та ін. Чітка рубрикація матеріалу звіту полегшує його захист. 



6 

 

У висновках повинні бути: 

- об'єктивна оцінка отриманих результатів і залежностей; 

- порівняння результатів експерименту з теоретичними положеннями 

або паспортними даними на обладнання і пояснення, у разі  необхідності,  

можливих причин розходжень результатів досліду з ними. 

Студент не починає виконувати наступну лабораторну роботу, якщо не 

оформив звіт з попередньої роботи і не виправив його відповідно до  за-

уважень викладача. 
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3 ЛАБОРАТОРНІ РОБОТИ 

 

 

3.1 Лабораторна робота № 1 "Цифрова обробка зображень за      

допомогою програми Digital Imaging Processing" 

 

Мета роботи – ознайомитись з програмою Digital Imaging Processing     

(DIP) і роботою з нею. Навчитись виконувати просторову цифрову оброб-

ку зображення в програмі DIP.  

 

Стислі теоретичні відомості 

 

Можливості програми  DIP 

DIP – програма обробки цифрових зображень, яка  являє собою 

ідеальне середовище для автоматизованого аналізу та моделювання 

графічних об'єктів. 

Повна версія DIP містить 200 функцій, що дозволяють підвищити ефе-

ктивність і швидкість обробки зображень: просторова обробка                

(квантування (quantization), дискретизація (discretization), частотна оброб-

ка,  трансформація колірного простору, аналіз пов'язаних компонентів, се-

гментація зображень за допомогою методу вододілу, виділення контурів за 

методом Canny і Shen-Castan, ретушування, шумозаглушення, операції з 

морфологією зображень, ітераційне і неітераційне відновлення зображень, 

спектральний аналіз (spectral analysis) і багато іншого. 

 

Дискретизація зображень 

 

 Дискретизація сигналу – це 

перетворення неперервного аналогового 

сигналу в послідовність його значень в 

дискретні моменти часу [1, 2]. Ці значення 

називаються відліками. Заміну зображення 

дискретним можна виконати різними 

способами. Найбільш поширеною є 

періодична дискретизація з прямокутним 

растром (рис. 3.1). Такий спосіб 

дискретизації може розглядатися як один 

з варіантів застосування ортогонального 

базису, що використовує як свої елементи 

зсуву δ-функції [3]. 

 

Рисунок 3.1 – Розміщення  

відліків при прямокутній  

дискретизації 
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Двовимірний спектр дискретного зображення є прямокутно-

періодичним з періодами 2π/Δt1 і 2π/Δt2 по осях частот відповідно Ω1 і Ω2. 

Спектр дискретного зображення Х(Ω1, Ω2) утворюється в результаті підсу-

мовування нескінченної кількості спектрів Хн(Ω1, Ω2) неперервного зобра-

ження, які відрізняються одне від одного частотними зсувами  2π/Δt1 і 

2π/Δt2 (рис. 3.2). 

 

Ω1    

Ω2

Ω1    

Ω2

2π/Δt2

2π/Δt2

 
              а)                                                                             б) 

 

Рисунок 3.2 – Частотні спектри неперервного  (а)                                              

і дискретного зображень (б) 

 

Вплив інтервалів дискретизації на відновлення зображень наведений на 

рис. 3.3. Зображення, яке являє собою відбиток пальця (рис. 3.3, а), має 

один з перетинів нормованого спектру (рис. 3.3, б). Дане зображення є 

дискретним, а як граничну частоту використано значення  2 128гр   . 

Рівень складових спектра на цій частоті досить малий, що гарантує якісне 

відтворення зображення.  

Наслідки від неправильного вибору інтервалів дискретизації можна 

побачити на рис. 3.3, в, г. При їх отриманні здійснювалася "дискретизація 

неперервного" зображення (рис. 3.3, а) шляхом проріджування його відлі-

ків. Зображення (рис. 3.3, в) відповідає збільшенню кроку дискретизації по 

кожній координаті в три, а зображення (рис. 3.3, г) – в чотири рази. Це бу-

ло б припустимо, якби значення граничних частот були меншими в таке ж 

число разів. У дійсності, як видно з рис. 3.3, б, відбувається порушення 

вимог теореми Котельникова, особливо грубе при чотириразовому прорі-

джуванні відліків. Тому відновлені за допомогою алгоритму двовимірної 

функції Найквіста [3, 7] зображення виявляються не тільки розфокусова-

ними, але і сильно спотворюють текстуру відбитка.  

На рис. 3.4 наведена аналогічна серія результатів, отриманих для зо-

браження типу "портрет" [3]. Наслідки більш сильного проріджування   (у 

чотири рази на рис. 3.4, в і в шість разів на рис. 3.4, г) проявляються в ос-

новному, у втраті чіткості. Суб'єктивно втрати якості виявляються менш 

значними, ніж на рис. 3.3. Це знаходить своє пояснення в значно меншій 

ширині спектра, ніж у зображення відбитка пальця. Дискретизація вихід-

ного зображення відповідає граничній частоті ωгр = 2π 86. Як видно з     



9 

 

рис. 3.4, б, це значення набагато перевищує реальну граничну частоту. То-

му збільшення інтервалу дискретизації (рис. 3.4, в, г) хоча і погіршує кар-

тину, все ж не призводить до таких руйнівних наслідків, як у попередньо-

му прикладі. 

 

 

а)                                                           б) 

 

в)                                                                  г) 

 

Рисунок 3.3 – Вплив інтервалу дискретизації на відновлення 

нерухомих зображень "Відбиток пальця" 

Двовимірний характер зображення порівняно зі звичайними сигналами 

містить додаткові можливості оптимізації цифрового подання з метою 

скорочення обсягу одержуваних цифрових даних. 

Слід сказати, що в переважній більшості випадків на практиці застосо-

вують дискретизацію, основану на використанні прямокутного растра, і 

рівномірне квантування яскравості. Це пов'язано з простотою виконання 

відповідних операцій. 
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а)                                                              б) 

      

 
в)                                                                    г) 

 

 

Квантування зображень 

Квантування – це розбиття діапазону значень неперервної або дискрет-

ної величини на кінцеву кількість інтервалів [4–6].  

При цифровій обробці зображень неперервний динамічний діапазон 

значень яскравості ділиться на ряд дискретних рівнів. Квантувач перетво-

рює неперервну змінну х в дискретну змінну хкв, яка набуває кінцевої мно-

жини значень (r1…rL) [1]. Ці значення називаються рівнями квантування 

(quant (quantization levels). В загальному випадку процес перетворення 

описується ступінчастою функцією (рис. 3.5). Якщо яскравість х відліку 

зображення належить інтервалу (dj…dj+1) (тобто, коли dj < х ≤ dj+1), то поча-

тковий відлік заміняється на рівень квантування rj. При цьому припуска-

ється, що динамічний діапазон значень яскравості обмежений і дорівнює 

[d1…dL+1]. 

Рисунок 3.4 – Вплив інтервалу дискретизації на відновлення зображення 

"Портрет" 
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Задача квантування полягає у визначенні значень порогів dj і рівнів rj. 

Найпростіший спосіб розв'язання цієї задачі полягає в розбитті динамічно-

го діапазону на однакові інтервали. Однак таке квантування не є найкра-

щим. Наприклад, якщо значення яскравості більшості відліків зображення 

згруповані, наприклад, в "темній" області та кількість рівнів L обмежено, 

то вигіднішим є нерівномірне квантування. В "темній" області потрібно 

квантувати частіше, а в "світлій" рідше. Це дозволить зменшити похибку 

квантування [5]. 

У системах цифрової обробки зображень прагнуть зменшити кількість 

рівнів і порогів квантування тому, що від цього залежить довжина двійко-

вого кодового слова. Однак, при відносно невеликому числі рівнів на про-

квантованому зображенні з'являються помилкові контури. Вони виникають 

внаслідок стрибкоподібної зміни яскравості квантованого зображення  

(рис. 3.6) і особливо помітні на пологих ділянках її зміни [3]. 

Помилкові контури значно погіршують візуальну якість зображення, 

тому зір людини особливо чутливий саме до контурів. Для рівномірного 

квантування (uniform quantization) типових зображень потрібно не менше 

64 рівнів. Результати рівномірного квантування зображення з 256 і 14 рів-

нями квантування, відповідно, наведені на рис. 3.7, а, б. 

 

dj+2

rj+1

dj+1

rj

dj Вихідний сигнал

Вхідний сигнал

 

Рисунок 3.6 – Механізм виникнення контурів 

Рисунок 3.5 – Функція, яка описує процес квантування 
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а)                                                             б) 

 

Рисунок 3.7 – Вплив рівномірного квантування  

 

У темних частинах зображення на рис. 3.7, б помітні помилкові конту-

ри. Використання нерівномірного квантування дозволяє суттєво знизити їх 

рівень (рис. 3.8, для 14 рівнів квантування). Гістограма яскравості зобра-

ження  при 256 рівнях квантування і відмічені пороги dj при L+1 = 15 на-

ведені на рис. 3.9. Із рисунка видно, що частіше квантуються ті області ди-

намічного діапазону, в яких згруповані значення яскравості відліків.  

Для нерівномірного квантування (non-uniform quantization), яке не мо-

же бути виконане за допомогою стандартного АЦП (analog to digital 

converter), використовують нелінійні перетворення   (рис. 3.10). Відлік х 

початкового зображення підлягає нелінійному перетворенню, щоб густина 

розподілення імовірностей перетворених відліків у була рівномірною, тоб-

то виконується процедура еквалізації. Потім відліки квантуються з рівно-

мірним кроком і піддаються зворотному нелінійному перетворенню. 

 

 
 

Рисунок 3.8 – Результат 

нерівномірного квантування 

Рисунок 3.9 – Гістограма зображення 

"Портрет" 
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Рисунок 3.10 – Квантування з попереднім нелінійним перетворенням 

 

Для руйнування неправильних контурів Робертс запропонував перед 

рівномірним квантуванням до відліків яскравості додавати шум з рівномі-

рною щільністю розподілення імовірностей. Дисперсія доданого шуму по-

винна бути невеликою, щоб не призвести до спотворень, які сприймаються 

як "сніг" на зображенні. Зазвичай використовують рівномірно розподіле-

ний шум на інтервалі [ -Δ/2, Δ/2 ]. Результати рівномірного квантування з 

рівнями зображення m = 14 і m = 8 та додаванням шуму наведені на       

рис. 3.11, а, б. При рівні квантування m = 8  доданий шум стає занадто по-

мітним, однак помилкові контури практично непомітні. 

 

 

а)                                                        б) 

 

Рисунок 3.11 – Результати рівномірного квантування з попереднім до-

даванням шуму (а − m = 8, б − m = 14) 

 

Частотна обробка зображень 

Пряме перетворення Фур'є (direct Fourier transform) функції f(t) визна-

чається як комплексна функція [3, 8]: 
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Обернене перетворення Фур'є (inverse Fourier transform) задається ви-

разом: 
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Перетворення Фур'є застосовуються для отримання частотного спектра 

неперіодичної функції, наприклад, електричного сигналу, тобто для по-

дання сигналу у вигляді суми гармонічних коливань.  

Дискретне перетворення Фур'є (ДПФ, direct discrete Fourier               

transform) – це математична процедура, що використовується для визна-

чення гармонічного або частотного складу дискретних сигналів. ДПФ є 

однією з найбільш розповсюджених і потужних процедур цифрової оброб-

ки сигналів. ДПФ дозволяє аналізувати, перетворювати і синтезувати сиг-

нали такими способами, які неможливі при неперервній аналоговій оброб-

ці. Тригонометрична форма подання прямого дискретного перетворення 

Фур'є: 

 
1

0

( ) ( )(cos(2 ) sin(2 ),
N
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де xn – відліки сигналу x(t) в дискретних часових точках; 

N – кількість виміряних за період значень сигналу, n = 0, 1, …, N-1; 

Х(m) – N комплексних амплітуд гаромонік, дійсна амплітуда гармоніки 
( )X m

N
; 

m = 0, 1, …, N-1 – індекс частоти, частота гармоніки 
m

T
. 

Обернене дискретне перетворення Фур'є (inverse discrete Fourier 

transform) має вигляд: 
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Швидке перетворення Фур'є (ШПФ) – швидкий алгоритм обчислення 

дискретного перетворення Фур'є. Якщо для прямого обчислення дискрет-

ного перетворення Фур'є з N точок даних потрібно N
2
 арифметичних опе-

рацій, то ШПФ дозволяє обчислити такий самий результат, використовую-

чи N logN операцій. Алгоритм ШПФ часто використовується для цифрової 

обробки сигналів, перетворення дискретних даних з часового у частотний 

діапазон. 
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Швидкодія ШПФ може, залежно від N, в сотні разів перевершувати 

швидкодію стандартного алгоритму. При цьому слід підкреслити, що ал-

горитм ШПФ є точним. Він навіть точніший стандартного, тому що скоро-

чуючи кількість операцій, він приводить до менших помилок округлення 

[3].  

Однак у більшості алгоритмів ШПФ є особливість: вони здатні працю-

вати лише тоді, коли довжина аналізованого сигналу N є ступенем двійки. 

Зазвичай це не є великою проблемою, оскільки аналізований сигнал зав-

жди можна доповнити нулями до необхідного розміру. Число N ще назива-

ється розміром або довжиною ШПФ. 

У випадку зображень, що являють собою двовимірний сигнал, спект-

ром є також двовимірний сигнал. Базисні функції перетворення Фур'є ма-

ють вигляд добутків: 
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де N1, N2 − розмір вихідного сигналу, він же – розмір спектра;  

m1, m2 – індекси частоти або номери базисних функцій (номери коефі-

цієнтів двовимірного ДПФ, при яких ці функції знаходяться); 

 n1, n2 – змінні аргументи базисних функцій [5]. 

Ефективний алгоритм обчислення ДПФ зображення полягає в обчис-

ленні одновимірних ШПФ спочатку від всіх рядків, а потім від всіх стовп-

ців зображення.  

При частотній фільтрації нерухомих зображень яскравість кожної точ-

ки вихідного зображення, спотвореного завадою, замінюється деяким ін-

шим значенням яскравості, при якому вплив завади найменший [5, 9].  

Лінійна фільтрація (linear filtering) найбільш часто використовується 

для приглушення обмеженого за частотою адитивного шуму. При цьому 

для кожного випадку необхідно синтезувати відповідний фільтр, врахову-

ючи частотний розподіл шумів [5]. 

Згладжування шуму забезпечується низькочастотною фільтрацією         

(low-frequency filtration). Істотним недоліком такої обробки є розмивання 

меж. Для підкреслення меж можна застосувати фільтр верхніх частот. Ін-

ший спосіб приглушення шумів на зображенні оснований на застосуванні 

медіанної фільтрації. Медіанна фільтрація (median filtration) дуже ефектив-

на для обробки зображень, спотворених завадами типу "сіль і перець", тоб-

то, коли на світлому фоні є темні точки ("перець") і на темному фоні світлі 

точки ("сіль") [5]. 
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Домашнє завдання 

 

1. Ознайомитися з можливостями програми обробки цифрових 

зображень DIP.  

2. Опрацювати теоретичний матеріал з основ дискретизації, 

квантування, фільтрації зображень. 

3. Заготовити три–чотири елементарних зображення (чорний фон, 

білий фон, дві полоски – чорна і біла) розміром 256×256 у форматі bmp. 

 

Лабораторне обладнання 

 

1. Комп'ютер. 

2. Програма DIP.  

 

Хід роботи 

 

Частина 1 

1. Запустити програму DIP. 

2.  Виконати просторову обробку зображення: 

2.1 . Здійснити квантування зображення. 

2.2 . Здійснити дискретизацію зображення. 

2.3. Вивести гістограми обробленого зображення та елементарних 

зображень. 

2.4. Виконати операції вирівнювання та стиснення однієї з отриманих 

гістограм. 

3.  Зробити висновки. 

 

Частина 2 

1. Виконати операції зашумлення зображення. 

1.1. Зашумлення зображення "білим шумом". 

1.2. Зашумлення зображення шумом "сіль і перець". 

2.  Виконати частотну обробку нерухомого зображення. 

2.1.  Операція прямого ШПФ. 

2.2.  Операцію оберненого ШПФ. 

2.3.  Виконати НЧ фільтрацію зображення. 

2.4.  Виконати ВЧ фільтрацію зображення. 

3.  Зробити висновки. 
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Методичні вказівки до виконання окремих пунктів роботи 

 

Частина 1 

1. Для запуску програму DIP два рази клацніть мишкою по ярлику 

програми. 

Початкове зображення вводиться за допомогою меню "Зображення" 

функція "Ввести". Досліджуване зображення повинно мати строгі розміри 

256×256. Зберегти зображення можна за допомогою меню "Зображення" 

функція "Записати". За необхідності введіть розширення зображення само-

стійно: jpg, jpeg, bmp і т. д. 

2. Для проведення квантування обираємо функцію "Квантувати", у 

вільне поле "Введіть кількість рівнів яскравості" записуємо можливий 

рівень квантування. Кількість рівнів яскравості відповідає розрядності 

квантування (2–256). Після введення числа натисніть Enter. 

Виконайте операцію квантування (рівні квантування 2, 8, 32, 128 і 256). 

Отримані результати занесіть в звіт (зробіть скріншоти отриманих 

зображень), порівняйте і зробіть висновки щодо якості зображення при 

різних рівнях квантування.  

3. Для проведення дискретизації обираємо функцію "Дискретизувати" у 

вільне поле "Введіть коефіцієнт дискретизації" вводимо число, після чого 

натискаємо Enter. Коефіцієнт дискретизації обираємо в межах 2–256. 

 Виконайте операцію дискретизації при коефіцієнтах дискретизації: 2, 

8, 32, 128 і 256. Отримані зображення порівняйте і зробіть висновок про 

спотворення. 

4. Для виведення гістограми вже квантованого за 128 рівнями 

яскравості і дискретизованого зображення в меню "Просторова обробка" 

обираємо функцію "Виведення гістограми". Отримайте і занесіть в звіт 

п'ять гістограм при різних коефіцієнтах дискретизації (2, 8, 32, 128 і 256).  

Вивести гістограми елементарних зображень (чорного, білого і дві 

смуги – меню "Зображення", "Створити", "Дві смуги"). Визначити, як 

розподілені відліки на гістограмі для цих зображень. 

 Для отримання гістограм проквантованого і продискретизованого 

зображення потрібно вибрати меню "Зображення", "Обмін" і потім 

"Виведення гістограми".  

Для виведення гістограми трьох елементарних зображень потрібно 

ввести елементарне зображення (меню "Зображення", "Ввести")  і в меню 

"Просторова обробка" вибрати функцію "Виведення гістограми".  

Порівняйте отримані результати і зробіть висновки щодо відповідності 

отриманих гістограм якості отриманих зображень. 

Гістограми можна вирівнювати (складові гістограми рівномірно 

розподіляються по графіку) і стискати (складові зсуваються праворуч в бік 

білого) за допомогою однойменних функцій "Вирівнювання гістограми" і 

"Стиск гістограми". Для виконання  функції "Стиск гістограми" у вільне 

поле вводимо коефіцієнт стискання. Дані коефіцієнти вибираємо в межах 
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1–8 і при цьому оцінюємо якість зображення. Для отримання гістограм 

рисунків потрібно виконати функцію "Обмін".  

 

Частина 2 

1. Для проведення операції "Зашумлення – Білий шум" потрібно у ві-

льне поле ввести коефіцієнт шуму, після введення числа натисніть Enter. 

Коефіцієнт шуму обирати в межах 2–512. Виконати операцію зашумлення 

для п'яти довільних рівновіддалених коефіцієнтів шуму. Отримані зобра-

ження порівняти і зробити висновок, при якому коефіцієнті шуму зобра-

ження найменше спотворилося і при якому спотворилося найбільше. Для 

цього вивести п'ять гістограм зашумленого зображення (при цьому потріб-

но виконати функцію "Обмін" початкового зображення і зашумленого). Ці 

операції можна виконувати одночасно. 

2. Для проведення операції "Зашумлення – Сіль і перець" потрібно у 

вільне поле ввести коефіцієнт шуму, після введення числа натиснути Enter. 

Коефіцієнт шуму обирати в межах 2–32000.  

3. Для отримання зображення, яке зазнало прямого ШПФ маємо 

обирати меню "Частотна обробка", функцію "Пряме ШПФ". Виконати 

пряме ШПФ для первинного зображення. Потім обирати функцію 

"Обернене ШПФ". Отримані результати прямого і оберненого ШПФ 

порівняти за зовнішнім виглядом. Пояснити, чому відновилось зображення 

після проведення оберненого ШПФ. Вивести гістограму відновленого 

зображення і порівняти її із гістограмою початкового зображення. 

Виконати пряме і обернене ШПФ для чорно-білого зображення і 

кольорового (зображення можна створити самостійно у програмі Paint, 

зображення має бути розміром 256×256). 

4. Зображення,  що  пройшло  через  ідеальні  фільтри  низьких  та  

високих  частот.  

За допомогою меню "Частотна обробка" вибрати  функцію "Ідеальний 

ФНЧ". У полі "Введіть частоту зрізу" вводимо частоту зрізу в діапазоні від 

2 до 256. Виконайте НЧ-фільтрацію для частот зрізу 256, 128, 64, 8. 

Зробити висновки щодо отриманих рисунків і визначити за зовнішнім 

виглядом рисунка, при якій частоті зрізу зображення можна ще відновити. 

За допомогою меню "Частотна обробка" вибрати  функцію "Ідеальний 

ФВЧ". У полі "Введіть частоту зрізу" ввести частоту зрізу в діапазоні від 2 

до 256. Виконайте ВЧ-фільтрацію для частот зрізу 4, 32, 64, 128, 256. 

Зробити висновки щодо отриманих рисунків і визначити за їх зовнішнім 

виглядом, при якій частоті зрізу зображення можна ще відновити. 

 

Контрольні запитання 

 

1. Дайте визначення теореми Котельникова. 
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2. Чим дискретизація аналогового одновимірного сигналу відрізняється 

від дискретизації зображення? 

3. Яка різниця між квантуванням аналогових одновимірних сигналів і 

нерухомих зображень? 

4. В яких випадках використовується нерівномірне квантування 

зображення? 

5. Назвіть переваги прямого і оберненого ШПФ. 

6. Що таке двовимірне ШПФ і як воно застосовується в обробці 

зображень? 

7. Для чого виконують НЧ- і ВЧ-фільтрацію цифрових зображень? 

8. Які точки знаходяться в центрі зображення після прямого ШПФ, які 

знаходяться по краях? 

 

 

3.2 Лабораторна робота № 2 "Цифрова обробка звукових сигналів" 

 

Мета роботи – навчитись здійснювати за допомогою програми Adas 

такі перетворення звукових сигналів: перетворення Фур'є, інтерполяцію     

(interpolation), децимацію (decimation), автокореляцію (autocorrelation), 

квантування. 

 

Стислі теоретичні відомості 

 

Перетворення Фур'є 

У частотному аналізі звукового сигналу використовують неперервне 

перетворення Фур'є (інтеграли Фур'є), дискретне перетворення Фур'є 

(ДПФ) та швидке перетворення Фур'є (ШПФ) [1, 2, 10]. 

Пара неперервного перетворення Фур'є має вигляд: 

 

,( ) ( ) exp( )

1
( ) ( ) exp( ) ,

2

S s t -j t dt

s t S w j t d

 

 










 

 

 

 

де ( )S   спектр сигналу ( )s t , в загальному випадку сигнал і спектр  

комплексні. 

Вирази для прямого і оберненого ДПФ мають вигляд: 

 
1

0

1

0

2
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ДПФ ставить у відповідність N  відлікам сигналу ( )s n , 0... -1n= N , в за-

гальному випадку комплексного, N  відліків комплексного спектра 

( )S k , 0... -1k = N . 

Як і в неперервному, так і в дискретному випадку, в виразах для обер-

неного перетворення є нормувальний коефіцієнт. У разі інтеграла Фур'є це 
1

2
, в разі ОДПФ −

1

N
. 

При неперервному перетворенні нормувальний коефіцієнт 
1 1

2 dt d 



 

необхідний для коректного масштабування сигналу з частотної області в 

часову. Нормувальний коефіцієнт 
1

2
 зменшує амплітуду сигналу на ви-

ході оберненого перетворювача для того, щоб вона збігалася з амплітудою 

вхідного сигналу.  

ШПФ – це алгоритм обчислення ДПФ за кількість операцій, меншу за 

N
2
. Часто під ШПФ розуміють швидкі алгоритми проріджування за часто-

тою, часом або алгоритми за основою два з кількістю операцій NlogN. За-

пропоновано багато різних алгоритмів ШПФ. 

 

Інтерполяція 

Інтерполяція – спосіб знаходження проміжних значень величини за на-

явним дискретним набором відомих значень [1, 11]. Існує також близька 

до інтерполяції задача, що полягає в апроксимації складної функції іншою, 

простішою функцією. Якщо початкова функція занадто складна для про-

дуктивних обчислень, можна спробувати обчислити її значення в декіль-

кох точках, а за ними побудувати, тобто інтерполювати, простішу функ-

цію. Зрозуміло, використання спрощеної функції не дозволяє одержати 

такі ж точні результати, які давала б початкова функція. Але досягнутий 

виграш у простоті і швидкості обчислень може переважити. 

     

 

Децимація 

Децимація – це зменшення частоти дискретизації дискретного в часі 

сигналу шляхом видалення його відліків [2, 11]. 

При децимації з вихідної послідовності відліків a0, a1, a2, … береться 

кожен N-й відлік a0, aN, a2N, …, де N − ціле число, більше за одиницю, N> 1. 

Інші відліки відкидаються.  

Перетворення спектра при децимації істотно залежить від спектра зву-

кового сигналу. Якщо звуковий сигнал не містить частот, що перевищують 

частоту Найквіста децимального сигналу, то форма спектра отриманого 

децимального сигналу збігається з низькочастотною частиною спектра 

звукового сигналу. Частота дискретизації децимального сигналу в N разів 

нижча, ніж частота дискретизації цифрового звукового сигналу. 

http://uk.wikipedia.org/wiki/%D0%97%D0%BD%D0%B0%D1%87%D0%B5%D0%BD%D0%BD%D1%8F
http://uk.wikipedia.org/w/index.php?title=%D0%94%D0%B8%D1%81%D0%BA%D1%80%D0%B5%D1%82%D0%BD%D0%B8%D0%B9&action=edit&redlink=1
http://uk.wikipedia.org/wiki/%D0%A0%D0%B5%D0%B7%D1%83%D0%BB%D1%8C%D1%82%D0%B0%D1%82
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Якщо звуковий сигнал містить частоти, що перевищують частоту Най-

квіста децимального сигналу, то при децимації матиме місце алиасинг (на-

кладання спектрів). 

Таким чином, для збереження спектра необхідно до децимації видали-

ти зі звукового сигналу частоти, що перевищують частоту Найквіста деци-

мального сигналу. Ця операція проводиться цифровими фільтрами. 

 

Автокореляція 

Автокореляція – це кореляція функції сама з собою, зміщеною на певну 

величину незалежної змінної, частіше часу. Автокореляція використову-

ється для знаходження закономірностей сигналу, наприклад, його періоди-

чності, швидкості зміни, частоти [6, 11].  

Математично автокореляційна функція визначається з виразу: 

 

( ) ( ) ( ) ,R f t f t dt
f
 





   

 

де інтегрується добуток функції ( )f t  з функцією ( )f t  , зміщеною на 

певний час τ. 

 

Квантування 

Під час квантування нескінченна множина можливих значень функції 

(амплітуд звукового сигналу) замінюється скінченною множиною дозво-

лених значень (дозволених рівнів амплітуд). Виконується округлення мит-

тєвих значень функції до найближчих дозволених. Квантування буває рів-

номірне та нерівномірне. При рівномірному квантуванні дозволені значен-

ня кратні кроку квантування – постійному числу [ 4, 5, 10 ]. 

Для якісного перетворення звуку кількість n дозволених рівнів його 

амплітуди при рівномірному квантуванні не менші 65536, а подальше його 

цифрове кодування здійснюється з розрядністю кодового слова  

 

2 265536 16.m log n log    

 

Домашнє завдання 

 

1. Вивчити теоретичний матеріал, що стосується виконання 

лабораторної роботи. 

2. Ознайомитися з методикою проведення лабораторної роботи. 

3. Одна хвилина запису цифрового аудіофайлу займає на диску 1,3 Мб, 

розрядність звукової плати 8. З якою частотою дискретизації записаний 

звук? 

4. Дві хвилини запису цифрового аудіофайлу займають на диску        

5,1 Мб, частота дискретизації  22050 Гц. Яку розрядність мав претворювач 

декодера? 
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Лабораторне обладнання 

 

1. Персональний комп'ютер, оснащений звуковою картою. 

2. Програма комп'ютерної обробки звуку Adas. 

 

Програма експериментальних досліджень 

 

1. Згідно з заданим варіантом (табл. 3.1) завантажити сигнал та зробити 

такі перетворення над ним: 

а) пряме перетворення Фур'є; 

б) обернене перетворення Фур'є; 

в) інтерполяцію  (кількість відліків вибираємо N=2,4,8); 

г) децимацію (коефіцієнт вибираємо N=2,4,8); 

д) отримати автокореляційну функцію сигналу. 

2. Провести квантування сигналу за п. 1 з різною кількістю відліків. 

3. Провести зашумлення сигналу за п. 1 рівномірним шумом та шумом 

Гаусса різних рівнів. 

4. Завантажити перетворений звуковий сигнал, прослухати його через 

навушники. Проаналізувати його по пунктах : 

а) сигнал з різним рівнем рівномірного шуму; 

б) сигнал з різним рівнем шуму Гаусса; 

в) здійснити децимацію сигналу (коефіцієнт вибираємо N=2,4,8); 

г) реалізувати інтерполяцію сигналу (кількість відліків вибираємо 

N=2,4,8); 

д) виконати квантування сигналу з різною кількістю квантів. 

5. Зробити висновки. 

 

Методичні вказівки до виконання окремих пунктів 

 

Запускаємо програму з робочого столу комп'ютера, далі згідно з отри-

маним варіантом завдання вибираємо тип сигналу, з яким потрібно робити 

перетворення. Далі у вікні програми "ФАЙЛ" вибираємо опцію "СТВО-

РИТИ СИГНАЛ". Перетворення Фур'є пряме та обернене вибираємо  у ме-

ню "ПЕРЕТВОРЕННЯ".  Для візуального спостереження сигналу  у часо-

вій та частотній формі потрібно у вікні "ГРАФІКИ" вибрати опцію "СИГ-

НАЛ" чи "ГРАФІК ФУР'Є". Далі у меню "ПЕРЕТВОРЕННЯ" вибираємо 

опцію "ДЕЦИМАЦІЯ" чи "ІНТЕРПОЛЯЦІЯ" (коефіцієнт інтерполяції та 

децимації 2
N
). 

Для того, щоб провести квантування сигналу, потрібно заново заван-

тажити вибраний сигнал, далі у меню "АНАЛОГ" вибрати "КВАНТУ-

ВАННЯ", ввести величину кванта та натиснути клавішу "ВВІД",  на моні-

торі з'явиться проквантований сигнал. 

  Для зашумлення сигналу потрібно завантажити заново сигнал, далі у 

вікні "КОРЕЛЯЦІЯ" вибрати опцію "ЗАШУМЛЕННЯ СИГНАЛУ", обрати 
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вид зашумлення (рівномірний чи Гаусса), ввести рівень шуму і натиснути 

"ВИКОНАТИ". 

Для завантаження звукового файлу потрібно у вікні "ЗВУК" обрати 

"ЗАВАНТАЖИТИ WAV-ФАЙЛ" із папки adas_z . 

  Для прослуховування потрібно у вікні "ЗВУК" вибрати опцію 

"СИНТЕЗ WAV-ФАЙЛУ", потім запис "СИНТЕЗОВАНИЙ СИГНАЛ" із 

подальшим збереженням його у папці програми. 

Для аналізу автокореляційної функції (autocorrelation function) потрібно 

із вікна "КОРЕЛЯЦІЯ" обрати "АВТОКОРЕЛЯЦІЙНА ФУНКЦІЯ". 

 

Варіанти завдань 

 

Таблиця 3.1 – Завдання для самостійного виконання 

 

№ 
Час 

початковий 

Час кін-

цевий 

Кіль-

кість 

точок, N 

Амплі-

туда 
Частота Тип сигналу 

1 0 2 32 90 40 Синусоїда 

2 0 3 64 100 38 Меандр 

3 0 4 128 110 36 Трикутник 

4 0 5 256 120 34 Пилка 

5 0 6 32 130 32 Синусоїда 

6 0 7 64 140 30 Меандр 

7 0 8 128 150 28 Пилка 

8 0 5 256 160 26 Трикутник 
 

Контрольні запитання 

 

1. Що таке  ДПФ і як воно застосовується в обробці звукових сигналів? 

2. Чим відрізняється алгоритм ШПФ від ДПФ? 

3. Як залежать параметри децимації від спектра звукового сигналу? 

4. Дайте означення автокореляції та опишіть її математично. 

5. З якою метою застосовують інтерполяцію? 

6. Які частоти дискретизації та розрядності квантування застосовують 

при цифровому перетворенні звукових сигналів?  
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3.3 Лабораторна робота № 3 "Цифрова фільтрація зображень" 

 

Мета роботи − дослідження способів покращення зображення за допо-

могою цифрових фільтрів (digital filter) в системі MATLAB 6.5. 

 

Стислі теоретичні відомості 

 

Лінійна фільтрація використовується для заглушення граничного за ча-

стотою адитивного шуму. При цьому, враховуючи частотний розподіл шу-

му, необхідно синтезувати відповідний фільтр [1, 12]. 

Згладжування шуму забезпечується низькочастотною фільтрацією. Іс-

тотним недоліком такої обробки є розмитість границь. Для підкреслення 

границь можна застосувати фільтр верхніх частот. Лінійну фільтрацію мо-

жна використовувати для видалення шумів певного типу. Для цього вико-

ристовують такі фільтри як усереднений і фільтр Гаусса. Наприклад, усе-

реднений фільтр використовується для видалення зернистості на зобра-

женнях.  

Другий спосіб заглушення шуму на зображенні реалізовано на основі 

застосування медіанної фільтрації. Медіанний фільтр – один з видів циф-

рових фільтрів, широко застосовується в цифровій обробці сигналів і зо-

бражень для зменшення рівня шуму. Медіанний фільтр є нелінійним КІХ-

фільтром. Значення відліків усередині вікна фільтра сортуються в порядку 

зростання або спадання. Ті значення, що знаходиться по центру упорядко-

ваного списку, надходять на вихід фільтра. У разі парної кількості відліків 

у вікні вихідне значення фільтра дорівнює середньому значенню двох   ві-

дліків по центру упорядкованого списку. Вікно переміщується уздовж сиг-

налу, що фільтрується, і обчислення повторюються. 

Суть медіанного методу фільтрації базується на упорядкуванні значень 

матриці інтенсивності. Медіанна фільтрація є нелінійним методом обробки 

зображення. Вона найбільш ефективна для усунення завад типу "сіль і пе-

рець", тобто коли на світлому фоні присутні темні точки ("перець") і на 

темному фоні світлі точки ("сіль"). Медіанна фільтрація є окремим випад-

ком рангової фільтрації. 

В пакеті MATLAB медіанна фільтрація реалізовується функцією 

"medfilt2" [13]. 

Функція D = medfilt2 (S, [mn]) створює півтонове зображення D, кожен 

піксель якого формується таким чином. Пікселі вихідного півтонового зо-

браження S, що відповідні всім елементам маски фільтра розміру mn, ста-

новлять упорядковану послідовність А пікселів D (r, с), де r і с – координа-

ти поточного положення центрального елемента маски. Медіаною впоряд-

кованої послідовності A (i), де i = 1 ... N, називається величина A((N+1)/ 2), 

якщо N непарне, і (A (N / 2) + A ((N +2 ) / 2)) / 2, якщо N парне. 

Для того, щоб розміри зображень S і D були однаковими, при прове-

денні обчислень, зображення S тимчасово доповнюється необхідною кіль-

http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A6%25D0%25B8%25D1%2584%25D1%2580%25D0%25BE%25D0%25B2%25D0%25BE%25D0%25B9_%25D1%2584%25D0%25B8%25D0%25BB%25D1%258C%25D1%2582%25D1%2580&usg=ALkJrhhV3jgFR5KbJESGTVJDjphX1nvNPg
http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A6%25D0%25B8%25D1%2584%25D1%2580%25D0%25BE%25D0%25B2%25D0%25BE%25D0%25B9_%25D1%2584%25D0%25B8%25D0%25BB%25D1%258C%25D1%2582%25D1%2580&usg=ALkJrhhV3jgFR5KbJESGTVJDjphX1nvNPg
http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A6%25D0%25B8%25D1%2584%25D1%2580%25D0%25BE%25D0%25B2%25D0%25B0%25D1%258F_%25D0%25BE%25D0%25B1%25D1%2580%25D0%25B0%25D0%25B1%25D0%25BE%25D1%2582%25D0%25BA%25D0%25B0_%25D1%2581%25D0%25B8%25D0%25B3%25D0%25BD%25D0%25B0%25D0%25BB%25D0%25BE%25D0%25B2&usg=ALkJrhgwuC-1g30ckyaM8IYDueve80KOvQ
http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A6%25D0%25B8%25D1%2584%25D1%2580%25D0%25BE%25D0%25B2%25D0%25B0%25D1%258F_%25D0%25BE%25D0%25B1%25D1%2580%25D0%25B0%25D0%25B1%25D0%25BE%25D1%2582%25D0%25BA%25D0%25B0_%25D0%25B8%25D0%25B7%25D0%25BE%25D0%25B1%25D1%2580%25D0%25B0%25D0%25B6%25D0%25B5%25D0%25BD%25D0%25B8%25D0%25B9&usg=ALkJrhhfADCjiguqCziFNk3tdM5YJdiwYw
http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A6%25D0%25B8%25D1%2584%25D1%2580%25D0%25BE%25D0%25B2%25D0%25B0%25D1%258F_%25D0%25BE%25D0%25B1%25D1%2580%25D0%25B0%25D0%25B1%25D0%25BE%25D1%2582%25D0%25BA%25D0%25B0_%25D0%25B8%25D0%25B7%25D0%25BE%25D0%25B1%25D1%2580%25D0%25B0%25D0%25B6%25D0%25B5%25D0%25BD%25D0%25B8%25D0%25B9&usg=ALkJrhhfADCjiguqCziFNk3tdM5YJdiwYw
http://translate.googleusercontent.com/translate_c?depth=1&ei=2WezUM2ED8XMtAbVm4DQBA&hl=uk&prev=/search%3Fq%3D%25D0%25BC%25D0%25B5%25D0%25B4%25D1%2596%25D0%25B0%25D0%25BD%25D0%25BD%25D0%25B8%25D0%25B9%2B%25D1%2584%25D1%2596%25D0%25BB%25D1%258C%25D1%2582%25D1%2580%26hl%3Duk%26tbo%3Dd%26biw%3D1280%26bih%3D709&rurl=translate.google.com.ua&sl=ru&u=http://ru.wikipedia.org/wiki/%25D0%25A8%25D1%2583%25D0%25BC&usg=ALkJrhhnV0UqynrW1ZCABg1Ny4nYdPeIIQ
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кістю рядків і стовпців нульовими пікселями. Формат подання даних ре-

зультувального зображення D збігається з форматом вихідного зображення 

S. 

Якщо вектор [mn] при виклику функції D = medfilt2 (S) не заданий, то  

як маска фільтра використовується маска розміру за замовчуванням. 

Функція Xd = medfilt2 (Xs, 'indexed', ...) аналогічна розглянутій вище, 

але призначена для обробки палітрових зображень. При проведенні обчис-

лень вихідне зображення тимчасово доповнюється або одиницями при   

форматі подання даних Xs-double, або нулями при форматі подання даних 

Xs-uint8. 

Ще одним методом покращення зображення є застосування фільтрації 

Вінера. В пакеті MATLAB функція "wiener2" використовує алгоритм адап-

тивної вінерівської фільтрації для подавлення гаусового шуму. 

Спектральна щільність сигналу (signal spectral destiny) визначається 

співвідношенням: 

 

( ) F ( ) ,IIS v R     

 

де  ( ) ( ) ( )R I x I x dx   – автокореляційна функція. 

 

Взаємна спектральна щільність сигналу визначається співвідношен-

ням: 

 

( ) F ( ) ,II'S v R     

 

де ( ) ( ) ( )R I x I x dx    – функція взаємної кореляції. 

При побудові фільтра Вінера ставиться завдання мінімізації середньок-

вадратичного відхилення (root mean square) обробленого зображення від 

первинного: 

 

 2

( , ) ( , ) min,E I x y I x y     

 

де  E  – математичне сподівання (mathematical expectation). 

 Перетворюючи ці вирази, можна показати, що мінімум досягається, 

коли передатна функція (the transfer function) визначається таким виразом: 

 
( , )

( , ) .
( , )

II x y

x y

II x y

S v v
D v v

S v v


  

 

Відновлення зображення повинно здійснюватися з використанням та-

кого  відновлювального перетворювача: 
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2

2

1
.

D( , )
( , )

D( , ) D( , ) ( , ) / ( , )

x y

x y

x y x y II x y II x y

v v
R v v

v v v v S v v S v v


   

  

 

Якщо шуму на зображенні немає, то спектральна щільність функції 

шуму дорівнює нулю і фільтр Вінера перетворюється на звичайний обер-

нений фільтр. 

При зменшенні спектральної щільності потужності вихідного зобра-

ження передатна функція фільтра Вінера прямує до нуля. Для зображень 

це є характерним на верхніх частотах. 

 

Домашнє завдання 

 

1. Вивчити теоретичний матеріал із запропонованої теми і підготувати 

форму звіту. 

2. Підготувати зображення з різним розширенням. 

3. Вивчити програму і методику проведення експериментів. 

 

Лабораторне обладнання 

 

1. Персональний комп'ютер з операційною системою Windows. 

2. Програмний пакет Іmage Tools для обробки зображення в системі 

MATLAB 6.5. 

 

Програма експериментальних досліджень 

 

1. Провести над зображенням (табл. 3.2) операції лінійної фільтрації: 

а) завантажити зображення; 

б) накласти на зображення шум "сіль та перець"; 

в) зашумлене зображення пропустити через усереднений фільтр; 

г) за допомогою медіанної фільтрації повернути зображення до почат-

кового стану. 

2. Провести над зображенням (табл. 3.2) операції адаптивної фільтра-

ції: 

а) завантажити зображення; 

б) надати зображенню градації сірого; 

в) накласти на зображення адитивний білий шум Гаусса; 

г) за допомогою фільтра Вінера позбутись попередньо накладеного 

шуму; 

3. Зробити висновки. 
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Методичні вказівки 

  

1. Запустити програму з робочого столу комп’ютера, завантаживши в 

пам'ять комп’ютера зображення формату gif, використовуючи функцію 

imread. Формат виклику меню такий: 

 І = imread('імя файлу'. 'формат'), де 'формат' – рядок, що відповідає  

формату збереження зображення tiff, bmp, jpg.  

Якщо файл збережений на диску, то формат виклику буде виглядати 

таким чином: 

І = imread('ім'я диска:\ім'я файлу. формат'), наприклад ('D: \image.jpg'); 

За допомогою функції imshow(І) вивести зображення на екран. 

2. Накласти на зображення шум "сіль та перець". 

Формат виклику: J = imnoise(I,'salt & pepper',d), де d – щільність шуму. 

Якщо її не вказувати, то за замовчуванням d=0.05. Вивести зображення на 

екран figure, imshow(J). 

3. Пропустити зашумлене зображення через усереднений фільтр          

K = filter2(fspecial('average',3),J)/255. Вивести результати на екран. 

4. Пропустити отримане зображення через медіанний фільтр                 

L = medfilt2(J,[3 3]). Вивести на екран зображення і у висновках порівняти 

його із зображенням, яке використовувалось у п. 1. 

5. Завантажити зображення (формат gif). Форма виклику: RGB = imread 

('ім'я файлу'. 'формат'). 

6. Надати зображенню градації сірого  I = rgb2gray('ім’я диска:\ім'я 

файлу.gif'); 

7. Накласти на зображення шум Гаусса. Формат виклику меню                

J = imnoise(I,'gaussian',M,V), де M – середнє значення шуму; V – дисперсія. 

Якщо параметри M і V не задані, то вважається, що M = 0, а V = 0,1. 

8. Застосувати фільтр Вінера для обробки попередньо зашумленого си-

гналу K = wiener2(J,[m n]), де m i n – розмір зображення (табл. 3.2) в піксе-

лях. Вивести зображення на екран і порівняти з початковим зображенням. 

 

Варіанти завдань 

 

Таблиця 3.2 – Завдання для самостійного виконання 

 

№ варі-

анта 

Щільність 

шуму 

Розмір зображення 

в пікселях по вер-

тикалі, m 

Розмір зображення 

в пікселях по гори-

зонталі, n 

М V 

1 0,01 128 128 0 0 

2 0,025 128 256 0,25 0,25 

3 0,05 128 256 0,5 0,5 

4 0,075 128 512 0,75 0,75 

5 0,1 128 512 1 1 
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M – середнє значення шуму, 

V – дисперсія. 

 

Контрольні запитання 
 

1. Що таке медіанна фільтрація, для чого вона використовується? 

2. Як впливає автокореляція на спектральну щільність сигналу? 

3. Чим відрізняється фільтрація Вінера від медіанної? 

4. Як видалити або додати шум до зображення і в яких випадках це за-

стосовують? 

5. Що таке шум на зображенні "сіль та перець"? 

6. Як зменшити вплив на зображення адитивного білого шуму Гаусса? 
 

 

3.4 Лабораторна робота № 4 "Дослідження параметрів та             

характеристик КД програвача" 

 

Мета роботи – ознайомитись з конструкцією КД програвача (CD   

player) тракту формування програм; визначити його технічні параметри та 

характеристики і провести порівняльний аналіз отриманих даних з відпо-

відним стандартом на даний вид апаратури. 

 

Стислі теоретичні відомості 

 

Загальні положення. Система "компакт-диск" (КД) складається з дис-

ка, який містить звукову програму, записану в цифровому вигляді, і про-

гравача, який відтворює записану інформацію за допомогою променя лазе-

ра. Діаметр компакт-диска становить 120 мм, товщина – 1,2 мм. Компакт-

диск може бути поміщений в тонкий конверт або спеціальну касету, що 

забезпечує портативність і зручність його зберігання [10,14, 15]. 

Якість звучання в системі КД визначається, як і в будь-якій цифровій 

системі звукозапису, параметрами аналого-цифрового і цифро-аналогового 

перетворень. Частоту дискретизації (sampling frequency) для цієї системи 

взято 44,1 кГц, число розрядів квантування (number of bits) – 16 при ліній-

ній характеристиці квантування. Вибір дробового значення частоти дис-

кретизації був обумовлений таким. Майстер-стрічка для першої копії диска 

записувалась комбінацією відеомагнітофона в системі PAL та ІКМ-

процесора, частота дискретизації якого становила 44,1 кГц.  

Цифровий запис з такими параметрами забезпечує високі якісні показ-

ники системи КД: 

 діапазон відтворюваних частот (replay frequency range) – від одиниць 

герц до 20 кГц; 

 відношення сигнал–шум (signal to noise ratio) – не менше 90 дБ; 

 динамічний діапазон (dynamic range) – не менше 90 дБ; 
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коефіцієнт нелінійних спотворень (non-linear distortion ratio) – 0,003% при 

максимальному рівні сигналу; 

 коефіцієнт детонації (wow and flutter, flutter rate) – нижче межі вимі-

рювання; 

 розділення каналів (the separation channels) – не менше 90 дБ. 

На відміну від грамплатівки в системі КД відсутні гуркіт і шуми, пов'я-

зані із запорошеністю і пошкодженнями поверхні носія інформації. Відсу-

тній також знос компакт-диска і головки зчитування [16, 17]. 

Запис цифрових сигналів на відміну від звичної грамплатівки здійсню-

ється тільки з одного боку компакт-диска. Зона запису сигналу обмежена. 

Її внутрішній діаметр дорівнює 50 мм, а зовнішній – 116 мм. Поза цією зо-

ною розташовується зона "введення і виведення", що містить інформацію, 

яка дозволяє автоматизувати процес програвання. Компакт-диск не має 

канавки запису, характерної для грамплатівки. Значення цифрового сигна-

лу записуються на поверхні диска за допомогою маленьких заглиблень, що 

називаються пітами. Розташовані в ряд піти утворюють доріжку запису, 

яка наноситься на диск у вигляді спіралі, направленої від центра диска до 

його краю. Відстань між сусідніми витками спіралі дорівнює 1,6 мкм. По-

рівняно з довгограючою пластинкою, де крок між канавками становить 

близько 160 мкм, тут щільність записування дуже висока. Завдяки цьому 

забезпечується неперервне відтворення однієї сторони диска діаметром 

120 мм протягом більше однієї години. 

Спочатку на поверхні прозорого пластмасового диска формують піти. 

Потім на диск із боку піт наноситься тонка металева плівка з високим кое-

фіцієнтом відбиття випромінювання лазера. Вона покривається непрозо-

рим захисним шаром. Захисний шар використовується також як етикетка. 

Доріжка запису, таким чином, залишається всередині компакт-диска.     

Сигнал зчитується з боку прозорої основи за допомогою сфокусованого 

променя лазера, який відбивається від поверхні металевої плівки і потрап-

ляє в оптичну систему головки зчитування. Металева плівка товщиною 

близько 0,1 мкм виготовляється з алюмінію, що надає компакт-диску     

характерного срібного кольору.  

Матеріал прозорої основи повинен  бути  теплостійким,  вологостій-

ким,   добре   формуватися  й  мати   гарні   оптичні властивості.  Захисний   

шар  виготовляється  з   непрозорої   твердої  пластмаси. 

Істотною перевагою системи КД є відсутність контакту між поверхнею 

диска і  головкою зчитування. Промінь лазера (the laser beam) фокусується 

до  плями, що має розмір одного порядку з розміром піт. Прогрес останніх 

років привів до появи дешевих за ціною напівпровідникових лазерів мале-

ньких розмірів. Вони встановлюються в малогабаритну оптичну головку 

зчитування програвача КД. Необхідна потужність  випромінювання 

(radiation power) лазерів становить 2÷3 мВт. 
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Розглянемо як відбувається зчитування цифрових сигналів, записаних 

на  компакт-диск. 

Сфокусований промінь лазера попав на  ділянку, де немає піт, майже 

повністю відбивається назад. Якщо промінь  попадає на ділянку, де розта-

шований піт, то він розсіюється. Довжина піта може змінюватися від 0,9 до 

3,1 мкм і набувати дев'яти значень. Відбитий промінь лазера модулюється 

відповідно до наявності чи відсутності піт на доріжці запису. Детектором  

відбитого випромінювання є фотодіод, він перетворює модуляцію           

світлового потоку на електричний сигнал.  

Внаслідок того, що промінь лазера фокусується на поверхні шару від-

биття, дрібні подряпини й порошини на диску не впливають на відтворе-

ний сигнал.  

На відміну від грамплатівки, що обертається з постійною швидкістю, 

частота обертання компакт-диска при відтворенні змінюється від 500 до 

200 об/хв. Це робиться для забезпечення постійного значення лінійної 

швидкості (1,25 м/с). Підтримка постійної лінійної швидкості дозволяє 

здійснювати запис піт з однаковою щільністю по всій поверхні компакт-

диска, що збільшує поверхневу щільність запису.  

Через малі розміри піт і крок доріжок існують проблеми забезпечення 

точного проходження променя лазера по доріжці запису. Компакт-диск 

встановлюється безпосередньо на вал двигуна. Реально важко забезпечити 

точне сполучення осі двигуна із центром диска. Неминуче існує зсув, ви-

кликаний ексцентриситетом і похибкою встановлення  компакт-диска на 

вал двигуна. Спостереження за доріжкою запису при відтворенні здійсню-

ється системою автотрекінгу.  

Через неідеальність виробничого процесу при тиражуванні компакт-

дисків можливе також деяке скривлення доріжок запису. Крім того, вироб-

ничі можливості й умови експлуатації не дозволяють мати абсолютно пло-

ский диск. Реальне биття поверхні диска при обертанні не може бути зроб-

лене меншим, ніж 0,5 мм. Це створює певні труднощі в забезпеченні пра-

вильного фокусування променя лазера на поверхні металевої плівки, оскі-

льки глибина піт становить 0,1 мкм. Щоб уникнути розфокусування при 

відтворенні, використовується спеціальна сервосистема, за допомогою якої 

підтримується постійною відстань між компакт-диском і об'єктивом. Ця 

система називається системою автофокусування (system of automatic 

focusing).  

Таким чином, в процесі відтворення промінь лазера постійно автома-

тично фокусується на шарі відбиття компакт-диска й безупинно стежить за 

доріжкою запису.  

Призначення органів керування, роз'ємів програвача КД Pioneer       

PD-106. На рис. 3.12 зображено програвач КД Pioneer PD-106. Лицьова па-

нель (рис. 3.12, а) має такі основні частини: 

1 – кнопка вмикання та  переводу програвача в режим очікування 

(STANDBY); 
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2 – індикатор режиму очікування (STANDBY); 

3 – дека для КД; 

4 – цифровий індикатор, що вказує порядковий номер треку, який 

програється; 

5 – індикатор, що вказує на режим, в якому працює програвач; 

6 – індикатор, що вказує на кількість хвилин, які пройшли після запу-

ску треку; 

7 – індикатор, що вказує на кількість секунд, які пройшли після запус-

ку треку; 

8 – кнопка відкриття та закриття деки для диска; 

9 – кнопка програвання/паузи; 

10 – кнопка стоп; 

11 – кнопка для пошуку/пропуску треку назад; 

12 – кнопка для пошуку/пропуску треку вперед; 

13 – кнопка, за допомогою якої вмикається режим програмування, – це 

дозволяє програвати треки за заданою послідовністю; 

14 – перемикає в режим час до закінчення треку; 

15 – вимикає цифровий дисплей; 

16 – вмикає випадковий вибір треків для програвання; 

17 – вмикає повтор треку, що програється; 

18 – вмикає режим швидкого програвання треків; 

19 – клавіша вибору треків в режимі PROGRAM. 

Тильна панель (рис. 3.12, б) має такі основні частини: 

1 – вихід для правого каналу; 

2 – вихід для лівого каналу; 

3 – вхід для подачі контрольних сигналів при налагодженні та ремонті 

пристрою; 

4 – вихід для зняття контрольних сигналів; 

5 – шнур живлення. 

 

Лабораторна установка 

 

Структурна схема лабораторної установки наведена на рис. 3.13. В ній 

штриховими лініями позначено вузли, які використовуються лише при ви-

конанні окремих пунктів досліджень. 

 

Домашнє завдання 

 

1. Уважно опрацюйте теоретичний матеріал. Вивчіть призначення ко-

жної клавіші програвача компакт-дисків. 

2. Ознайомтесь з ходом роботи та методикою вимірювань основних 

параметрів та характеристик програвача. 

3. Вивчить схемотехніку програвачів компакт-дисків. 
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Вимірювальна і досліджувана апаратура 

 

1. Тест-диск "Контроль и настройка оборудования в радиовещании и 

звукозаписи". 

2. Програвач КД Pioneer PD-106. 

3. Осцилограф С1-83. 

4. Вольтметр В3-38. 

5. Вимірювач нелінійних спотворень С6-5. 

6. Фільтр НЧ "150Гц". 

7. Підсилювач "Радиотехника У-101С". 

8. Акустична система 35АС-016. 

9. Смуговий фільтр "20 Гц – 20 кГц". 

 

Програма експериментальних досліджень 

 

1. Вивчити опис та структуру тест-диску ,,Контроль и настройка об   

рудования в радиовещании и звукозаписи’’. 

Увага, треки відмічені знаком , не призначені для прослухову-

вання та можуть пошкодити акустичну систему. При підключені гуч-

номовців та підсилювача слід уникати програвання даних треків. 

2. Ознайомитись з принципом дії та роботою програвача КД Pioneer PD-

106. 

3. Вивчити призначення функціональних клавіш та індикаторів на ли-

цьовій панелі пристрою. 

4. Виміряти амплітудно-частотну характеристику програвача КД для 

кожного з каналів. Для цього послідовно включити треки 82..99, що відпо-

відають частотам, наведеним у табл. 3.3, та  виміряти напруги лівого і пра-

вого каналів. Отримані дані занести до табл. 3.3. 

 

Таблиця 3.3 — Вимірювання АЧХ 
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Рисунок 3.13 − Структурна схема лабораторної установки ( О − осцилог-

раф, Ф − ФНЧ "150 Гц" або смуговий фільтр "20 Гц - 20 кГц", В − вольт-

метр, ВНС − вимірювач нелінійних спотворень, ППЗЧ − підсилювач поту-

жності звукової частоти, АС − акустична система ) 

 

5. Визначити розділення між каналами. Щоб визначити, чи присутні 

складові лівого каналу в правому, і навпаки − правого в лівому, необхідно 

сигнали обох каналів подати на осцилограф. Далі, ввімкнувши на програ-

вачі треки 46 (для лівого каналу) та 51 (для правого), спробувати знайти на 

екрані осцилографа  зображення синусоїдальних складових за рахунок па-

разитного проходження напруги лівого каналу в правий (правого в лівий). 

Якщо ці складові будуть знайдені, розділення між каналами розрахувати за 

формулою: 

DР=201g(UЛ(П  ) / UП(Л)), 

 

де в чисельнику напруга лівого або правого каналу, а в знаменнику – 

паразитна напруга, відповідно, в правому або лівому каналі. 

6. Виміряти, за допомогою смугового фільтра "20 Гц – 20 кГц", відно-

шення сигналу до шуму в обох каналах. Якщо при виконанні п. 5 паразит-

не проходження сигналів із каналу в канал не було зареєстровано, то вимі-

рювання відношення сигналу до шуму можна проводити за допомогою 

треку 46 (для лівого каналу) і треку 51 (для правого каналу). Додатково 

визначити співвідношення сигнал/шум на частоті 5 кГц, для чого викорис-
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тати трек 37 для лівого і правого каналів. Отримані дані занести до       

табл. 3.4.  

 

Таблиця 3.4 − Вимірювання відношення сигнал/шум 

 

F, Гц 1000 5000 F, Гц 1000 5000 

Uл, В   Uп, В   

Uл шум, мВ   Uп шум, мВ   

 

Співвідношення сигнал/шум визначають за виразом: 

 

DШ=201g (UС /UШ ), 

 

де UС − напруга сигналу, UШ − напруга шуму. 

Виміряти шумову напругу в режимі "Стоп". Порівняти  відношення си-

гнал/шум в режимі "Стоп" і у режимі "Програвання". 

7. Виміряти за допомогою фільтра НЧ "150 Гц" відношення сигнал/фон 

для двох каналів.  

Вимірювання за цим пунктом виконуються відповідно до рекомендацій 

до п. 6. Отримані дані занести до табл. 3.5.  

 

Таблиця 3.5 − Вимірювання відношення сигнал/фон 

 

F, Гц 1000 5000 F, Гц 1000 5000 

Uл, В   Uп, В   

Uлфон, мВ   Uпфон, мВ   

 

Замалювати осцилограми фонових напруг для лівого і правого каналів. 

Співвідношення сигнал/фон визначити за виразом: 

 

DФ=201g (UС  /UФ ), 

 

де UС − напруга сигналу; 

UФ − напруга фону. 

8. Визначити за допомогою треків 14...28 амплітудну характеристику 

програвача КД. Для цього виміряти вихідну напругу каналів та занести її 

до табл. 3.6. 
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Таблиця 3.6 − Вимірювання АХ  
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9. Визначити коефіцієнт гармонік програвача. Вимірювання цього кое-

фіцієнта здійснюється на частоті 1кГц за допомогою тестового сигналу з 

треку  93 або 14. 

10. Перевірити синфазність вихідних напруг програвача. Якщо осцило-

грами сигналів лівого і правого каналів при відтворенні треків 29 і 30 про-

тилежні, то це означає, що в програвачі порушена синфазність. 

Зарисувати осцилограми треків 29, 30 для обох каналів. 

11. Дослідити вихідні сигнали програвача КД на високих частотах, по-

слідовно вмикаючи треки 38..43, що відповідають частотам 19; 20; 20,5; 21; 

21,5; 22 кГц. Зарисувати осцилограми,  зробити їх аналіз. Навести необхід-

ні висновки. 

12. Дати суб'єктивну оцінку якості звучання програвача КД.  При вико-

нанні цього пункту потрібно під'єднати до програвача стереопідсилювач з 

акустичними системами та запустити музичний  трек 72. 
  

Контрольні запитання 

 

1. Поясніть принцип роботи програвача КД. 

2. Яким чином відбувається зчитування інформації? 

3. Що зроблено в програвачі для того, щоб надійно зчитувати інформа-

цію з доріжки диска? 

4. Від чого залежить шумова напруга програвача і чому при програ-

ванні відношення сигнал/шум гірше, ніж в режимі "Стоп".  

5. Чому можливо для вимірювання шумової та фонової напруги вико-

ристовувати треки, де є відсутніми сигнали почергово в лівому і правому 

каналах (тобто треки для перевірки розділення між каналами)? 

6. На основі отриманих результатів порівняйте параметри досліджува-

ного програвача з існуючими стандартами. 
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3.5 Лабораторна робота № 5 "Дослідження квадратурно-

амплітудної та відносної фазової маніпуляції" 
 

Мета роботи – отримати знання та практичні навички в дослідженні 

модуляторів та демодуляторів квадратурно-амплітудної (КАМ) (quadrature-

amplitude manipulation) та відносної фазової маніпуляції (ВФМ) (the phase 

manipulation). 

 

Стислі теоретичні відомості 

 

Методи цифрової маніпуляції 

Особливістю цифрової маніпуляції (digital manipulation) несу-                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         

чих є те, що кожній з комбінацій цифрового сигналу відповідає своя власна 

комбінація значень амплітуди, частоти і фази або певний перехід від однієї 

групи значень до іншої. У першому випадку реалізовується абсолютна ма-

ніпуляція, другому – відносна [1, 20]. 

Відповідність цифрових сигналів і параметрів несучої встановлюється 

таблицями істинності або сигнально-кодовими діаграмами. 

При цифровій маніпуляції модульований сигнал являє собою послідов-

ність радіоімпульсів з фіксованими значеннями амплітуди, частоти та по-

чаткової фази. При цьому, як правило, радіоімпульс складається з цілого 

числа періодів коливання. Тоді сигнал з n  фрагментів можна описати та-

кою математичною моделлю: 
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Спектр такого сигналу зосереджений поблизу несучих частот, а бічні 

смуги відповідають або аналогічні спектру одиночного прямокутного ім-

пульсу. 

При необхідності передачі цифрової інформації з високою швидкістю 

можна використовувати багатопозиційні маніпуляції – просту або комбі-

новану.  

У першому випадку кількість позицій визначається степенем числа 

два. В результаті збільшується щільність розміщення позицій і збільшуєть-

ся імовірність помилки. На практиці, зазвичай, обмежуються вісьмома зна-

ченнями одного параметра.  

При комбінованій маніпуляції найбільш ефективною є амплітудно-

фазова маніпуляція, при якій дійсно звужується відносно  швидкості пере-

дачі ефективна ширина спектра сигналу. Коефіцієнт звуження дорівнює 

числу одночасно переданих біт. 

Спектральна ефективність (spectral efficiency) сигналу визначається за 

формулою: 
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r
 


 , 

 

де r  – швидкість передачі даних,  

 – ефективна ширина спектра. 

Амплітудно-фазова маніпуляція (amplitude-phase manipulation) може 

бути різних типів, але найбільш поширеною є КАМ.  

 

Квадратурно-амплітудна  маніпуляція 

Для збільшення швидкості передачі даних використовують так звану 

квадратурно-амплітудну маніпуляцію КАМ (рис. 3.14), яка є амплітудно-

фазовим видом маніпуляції. КАМ застосовується в кабельних модемах, у 

стандарті цифрового телебачення DVB (digital video broadcasting), а також 

в цифровому радіомовленні (digital broadcasting) [18, 19].  

 

Рисунок 3.14 – Векторна діаграма сигналу КАМ-16 (ліворуч) і сузір'я 

сигналу КАМ-32 (праворуч) 

Знаючи, що 16 = 2
4
, в КАМ-16 одним символом можуть бути передані 

чотири біти. Це означає, що символьна швидкість у такому вигляді мані-

пуляції виходить в чотири рази меншою бітової, тобто дорівнює 1/4 від 

бітової швидкості. Таким чином, даний тип маніпуляції дозволяє організу-

вати спектрально більш ефективну передачу даних. З точки зору швидкості 

передачі цей вид маніпуляції набагато ефективніший  порівняно з двійко-

вою (BPSK), чотирипозиційною (QPSK) або восьмипозиційною (8 PSK) 

фазовою маніпуляцією. Слід відразу сказати, що QPSK і КАМ-4 насправді 

один і той же вид маніпуляції. Ще один різновид КАМ – це КАМ-32. Її ха-

рактеристики такі: по шість сигнальних значень для I і Q, що в підсумку 
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дає 6×6 = 36 точок сузір'я для сумарного сигналу. Цей тип маніпуляції на-

ділений особливістю. Кількість значень 36 не відповідає вихідним даним, 

вона занадто велика (36>32). Тому чотири "кутових" сигнальних значення, 

на які припадає більша потужність передавача, видалені. Цим зменшується 

вихідна потужність передавача. Виходячи з того, що 32 = 2
5
, отримуємо 

бітову швидкість 5 біт/с і символьну швидкість, що дорівнює 1/5. 

 

Відносна фазова маніпуляція 

 

Неоднозначність, що характерна для фазоманіпульованих (ФМн) сиг-

налів, усунена у відносній фазовій маніпуляції (ВФМ). У такого методу 

маніпуляції інформація закладена не в абсолютному значенні початкової 

фази, а в різниці початкових фаз сусідніх посилань, яка залишається не-

змінною і на приймальній стороні. Для передачі першого двійкового сим-

волу в системах з ВФМ необхідне одне додаткове посилання сигналу, пе-

редане перед початком передачі інформації, воно відіграє роль відлікового 

[18, 19]. 

Процес формування сигналу з ВФМ можна звести до випадку форму-

вання сигналу з ФМн шляхом перекодування двійкової послідовності, що 

передається. Для отримання сигналу з ВФМ достатньо помножити отри-

ману закодовану послідовність на несуче коливання. Структурна схема 

модулятора ВФМ (рис. 3.15) містить генератор несучого коливання (Г), 

фазовий модулятор (ФМ) і кодер, який складається з перемножувача              

(multiplier) і елемента пам'яті. 

Демодулятор сигналу з ВФМ містить фазовий детектор (ФД), який 

складається з перемножувача і ФНЧ, генератор несучого коливання (Г) та 

декодер (рис. 3.15).  

 

Кодер ВФМ

ФМ

Г Декодер ВФМ

ФМ

Г
 

 

Рисунок 3.15 – Модулятор та демодулятор ВФМ 

 

На рис. 3.16 наведені часові діаграми формування сигналу ВФМ.  
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Рисунок 3.16 – Часові діаграми формування ВФМ-сигналів (а –  неперіо-

дичний інформаційний сигнал, б –  інформаційний сигнал у відносному 

коді, в – несуче коливання, г – сигнал ВФМ на виході модулятора) 

 

Домашнє завдання  

 

1. Вивчити теоретичні відомості, які стосуються цифрових маніпуляцій 

КАМ та ВФМ. 

2. Повторити основи роботи в програмних середовищах MathCAD та            

MatLAB. 

3. Дати відповіді на контрольні запитання. 

 

 

Лабораторне обладнання 

 

1. Персональний комп’ютер, укомплектований відповідно до 

системних вимог програм MatLAB i MathCAD. 

2. Програми MathCAD 14 i MatLAB 6.2 

 

Порядок виконання роботи 

 

Частина 1 

1. Провести дослідження КАМ відповідно до запропонованих варіантів                    

(табл. 3.7) в MathCAD, написати математичну модель сигналу КАМ.  

2. Дослідити залежність ширини спектра сигналу КАМ-16 від 

швидкості передачі. 
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3. Провести дослідження спектральної ефективності КАМ при різних 

швидкостях. Порівняти спектральну ефективність ВФМ сигналу з КАМ 

сигналом. 

4. Зробити висновки за отриманими даними та залежностями. 

 

Частина 2 

1. Провести дослідження КАМ згідно з запропонованими варіантами             

(табл. 3.8) в MatLAB, написати математичну модель сигналу КАМ. 

2. Отримати сигнал на виході модулятора КАМ для різних частот 

дискретизації, несучих частот і при зміні вхідних послідовностей. 

3. Зробити висновки за отриманими даними та залежностями. 

 

Методичні вказівки до виконання окремих пунктів 

 

Частина 1 

1. Запускаємо програму MathCad 14.0, створюємо новий файл для 

введення тексту програми, вибираємо варіант для свого тракту КАМ та 

ВФМ маніпуляції. 

2. Задаємо довжину двійкової послідовності, індекс маніпуляції та век-

тори двійкової послідовності, заносимо у таблицю комбінації коду: 

 
n:=16, f:=3∙10

3
,Vb=1200 

Nmax 2
n

  

 

i 0 Nmax 1  
 

X
i

ceil rnd 1( ) 0.5( )
 

3. Записуємо вираз для утворення вихідних кодових комбінацій, після 

чого готові комбінації записуємо у вигляді таблиці за допомогою 

середовища MathCAD. 

 

TbSymb

TbSymb
0 i 

X
i 4



TbSymb
1 i 

X
i 4 1



TbSymb
2 i 

X
i 4 2



TbSymb
3 i 

X
i 4 3



i 0 trunc
Nmax

4









1for

TbSymb



 
4. Задаємо вирази для формування сигналів модулятора КАМ. 
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I NSymb( ) xi 1 TbSymb
1 NSymb 

if

xi 1 otherwise

yi 3 TbSymb
3 NSymb 

if

yi 1 otherwise

I xi yi



 
Q NSymb( ) xq 1 TbSymb

0 NSymb 
if

xq 1 otherwise

yq 3 TbSymb
2 NSymb 

if

yq 1 otherwise

Q xq yq



 
 

5.  Заносимо частоту в герцах та швидкість передачі, що задані у 

варіанті. На основі вище розрахованих даних обраховуємо період, кругову 

частоту, тривалість одного біта, швидкість передачі символу та тривалість 

одного символу відповідно до формул: 

 

T
1

f


          
Tb

1

Vb


            
Vs

Vb

4


            
Ts

1

Vs


 
   

  2 f   
 

6.  Формуємо графіки, що проілюструють швидкість передавання 

символів за одиницю часу, для чого записуємо відповідні аналітичні 

вирази та будуємо залежність рівнів сигналів на виходах від часу: 

 

I2 t( ) k floor
t

Ts











I k( )



         

Q2 t( ) k floor
t

Ts











Q k( )



 
 

7. Задаємо аналітичний вираз для формування рівнів сигналу та 

формуємо графік для наочної демонстрації: 

 

y t( ) I2 t( ) cos  t( ) Q2 t( ) sin  t( ) . 

 

Викликаємо меню графіків: Insert-> Graph-> X-Y Plot або 

використовуючу швидкі клавіші Shift та 2. 

8. Відповідно до формул, поданих нижче, знаходимо частоту 

дискретизації, період дискретизації, кількість точок, час спостерігання, 
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кількісті символів та періодів сигналу, які містять один символ (у формулі 

для кількості точок степінь вибираємо відповідно до варіанта): 

 

fd 10 f      
 

Td
1

fd


     
 

K 2
12

     
   

Ts

T
10

  
 

Tobs K Td     
   

Tobs

Ts
40.96

     
 

9. Формуємо спектр сигналу для періодів сигналу, що містять один 

символ. 

 

10. Формуємо вираз сигналу для подальшого обрахунку швидкості 

передавання інформації. 

 

   
 

W
820

Tobs


 
 

11.  Записуємо аналітичний вираз для швидкості передавання 

інформації: 

 

Ydi := y(Td ∙ i) 

 

SpecY fft Yd( )  

 

k2 0 last SpecY( )  
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W1 k trunc f Tobs( )

ss 1

ps1

k 1

k 1

n

SpecY
n 

2






level
ps1

Pfull


ss ss 1

ps1

k ss

k ss

n

SpecY
n 

2






level
ps1

Pfull


level 0.95while

2 ss



             
Wf

W1

Tobs


 
 

12.  Задаємо послідовність для формування графіка спектральної 

ефективності та порівняння її з спектральною ефективністю сигналу з 

ВФМ. Записуємо у вигляді матриці дані для  Gr, далі записуємо формулу 

для  визначення змінної та записуємо формули для задання табличних 

значень спектральної ефективності сигналу КАМ та ВФМ (формуємо два 

графіки: перший є залежністю Gj,1 від Gj,0, другий є залежністю Gj,0/Gj,1 від 

Gj,0) 

 

j 0 rows Gr( ) 1            
 

13. Формуємо сигнали з виходу модулятора, для цього записуємо 

аналітичні вирази вихідних сигналів y1(t) і y2(t): 

 

 

 

 

 

 

Формуємо вихідні сигнали y3(t) і y4(t): 

y0 t( ) y t( )  

d1 : = Ts + 0.00025         Ur1 0  

 
 
 

Ur2 0  

 
 

y2 t( ) 0 t d2if

Ur2 y t d2( ) t d2if


 

y1 t( ) 0 t d1if

Ur1 y t d1( ) t d1if


 

d2
T

2
  
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y3 t( ) 0 t d3if

Ur3 y t d3( ) t d3if



 
 

y4 t( ) 0 t d4if

Ur4 y t d4( ) t d4if



 
           

14.  Записуємо загальну математичну модель КАМ–сигналу з виходу 

модулятора та будуємо графік сигналу. 

 

y t( ) y0 t( ) y1 t( ) y2 t( ) y3 t( ) y4 t( ) . 

 

Частина 2 

1. Запускаємо програму MATLAB 6.5, створюємо новий файл для 

введення тексту програми, вибираємо варіант для КАМ. 

2. Вводимо перші рядки програми, для задання кількості символів і 

зміни випадкових цілих чисел із діапазону 0…3, тобто значення a1 і b1 

будуть змінюватись від -3 до +3. 

 

>> N=100;      %кількість символів; 

>> aa=randint(1,N,4); % випадкові цілі числа;  

>> bb=randint(1,N,4); % випадкові цілі числа;  

>> a1=2*aa-3; % закон зміни випадкових цілих чисел; 

>> b1=2*bb-3; % закон зміни випадкових цілих чисел. 

 

3. Переписуємо код програми (п. 4), для відповідного варіанта несучої 

частоти Fc; зобразити три осцилограми вихідного сигналу для двох 

сусідніх відліків на один символ, тобто для трьох значень FsFd. 

 

4. Для відповідного варіанта кількості відліків на один символ 

зобразити три осцилограми вихідного сигналу для двох сусідніх несучих 

частот, тобто для трьох значень Fс: 

>> Fd=1200;  %  швидкість символів; 

>> Fc=1800;  % несуча частота; 

>> FsFd=8;  % кількість відліків на один символ; 

>> Fs=Fd*FsFd;  % частота дискретизації; 

>> a1=repmat(a1,FsFd,1); 

>> a1=a1(:); 

>> b1=repmat(b1,FsFd,1); 

d4
Ts

2
  d3 := 2Ts + 0.0005 Ur4 0  

             Ur3 0  
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>> b1=b1(:); 

>> t=(0:N*FsFd-1)/Fs; 

>> t=t'; 

>> s_qask16=a1.*cos(2*pi*Fc*t)+b1.*sin(2*pi*Fc*t); 

>> plot(t(1:100),s_qask16(1:100)). 

 

5. В середовищі MATLAB 6.5 скласти блок схему (рис. 3.17) і 

отримати сигнальне сузір'я для КАМ16 . 

 
Рисунок 3.17 – Блок-схема модулятора КАМ16 

 

В кожних блоках відповідної схеми поля повинні бути заповнені 

відповідно до рис. 3.18–3.21: 

 

 
 

Рисунок 3.18 – Вікно нараметрів Randon Integer Generator 
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Рисунок 3.19 – Вікно параметрів QAM Modulator Baseband 
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Рисунок 3.20 – Вікно параметрів Discrete-Time Scatter Plot Scope 



49 

 

 
 

Рисунок 3.21 – Вікно параметрів Discrete-Time Signal Trajectory Scope 
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Варіанти завдань  

 

Таблиця 3.7 – Завдання для самостійного виконання 

 
Номер варіанта I II III IV V VI 

n (довжина двійко-

вої послідовності) 

10 9 7 5 11 15 

f, кГц 15 1 6 12 8 24 

Символьна швид-

кість,Vb 
900 1050 1200 1350 1500 1650 

 

Таблиця 3.8 – Завдання для самостійного виконання 

 
Номер варіанта I II III IV V VI 

Fc 1200 1400 1500 1600 1800 2000 

FsFd 8 12 16 8 12 16 

 

Контрольні запитання 

 

1. Записати і пояснити формулу для спектральної ефективності сигналу 

при цифровій маніпуляції. 

2. Квадратурно-амплітудна маніпуляція – поняття, спосіб реалізації, 

сигнальне, сузір'я КАМ-сигналу. 

3. Навести структурну схему модулятора КАМ. 

4. Навести структурну схему когерентного демодулятора КАМ. 

5. Описати спектр сигналу з КАМ. 

6. Навести структурну схему модулятора ВФМ,  пояснити принцип 

його дії. 

7. Навести структурну схему демодулятора ВФМ,  пояснити принцип 

його дії. 

8. Описати спектр сигналу з ВФМ. 

 
 

3.6 Лабораторна робота № 6 "Комп'ютерна обробка звуку за допо-

могою аудіоредактора Sound Forge" 

 

Мета роботи − отримання практичних навичок комп'ютерної обробки 

звуку за допомогою професійного редактора. 

 

Стислі теоретичні відомості 

 

Існує безліч аудіоредакторів для записування і обробки звуку і вибір 

будь-якого з них безпосередньо залежить від цілей, які ви перед собою 

ставите. Однією з таких програм, призначених для обробки аудіо на про-
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фесійному рівні, є Sound Forge фірми Sonic Foundry Inc. З її допомогою 

можна обробляти аудіосигнал, змінюючи його до невпізнання або ж реда-

гувати невдало записану партію якого-небудь музичного інструменту. 

Sound Forge успішно поєднує у собі практично повний набір сучасних зву-

кових ефектів і потужні засоби редагування звуків для наступного їх вико-

ристання [21, 22]. 

Завдяки зручному інтерфейсу і великому числу підпрограм з програ-

мою можна успішно працювати також і на аматорському рівні. Детальніше 

про програму можна почитати в розділі "Методичні вказівки до виконання 

роботи". 

Редактор Sound Forge 4.5h при установленні відповідної бібліотеки до-

зволяє безпосередньо редагувати файли у форматі MP3. Найчастіше вико-

нується редагування файлів у вихідному форматі WAV, а потім здійсню-

ється компресія з втратами. При такій компресії в результуючому файлі 

втрачається частина інформації з вихідного файлу, виявляється неможли-

вим повне відновлення файлу. Алгоритми з втратами дозволяють отримати 

більш ефективне стиснення порівняно з алгоритмами без втрат, які засто-

совуються, наприклад, в програмах-архіваторах. 

Найбільш поширеним форматом зберігання стисненого аудіо є MP3 − 

скорочення від MPEG Layer3. Цей формат затверджений як частина стан-

дартів кодування відео- і аудіосигналів MPEG1, MPEG2. Він використову-

ється, головним чином, для передавання звукових сигналів в реальному 

часі по мережевих каналах радіо-, телемовлення. 

MP3 – потоковий формат. Це означає, що вихідний сигнал при коду-

ванні розбивається на ділянки за тривалістю або фрейми (frame).  

Мінімальні суб'єктивні втрати якості кодованого в MP3-сигналу дося-

гаються за допомогою врахування особливостей людського слуху. Одна з 

них − це маскування слабкого сигналу одного частотного діапазону більш 

потужним сигналом іншої частоти. Інша особливість полягає в тому, що 

потужний сигнал попереднього фрейму викликає тимчасове зниження чут-

ливості вуха до сигналу поточного фрейму. Також враховується нездат-

ність більшості людей розрізняти сигнали,  потужності яких лежать нижче 

порогових рівнів.  

Ступінь стиснення сигналу визначається таким параметром, як бітрейт 

(bitrate). Він визначає, скільки одиниць інформації потрібно для зберігання 

однієї секунди звучання фонограми. Загальноприйнята одиниця виміру бі-

трейта − кілобіт на секунду (Кбіт/с або kbs).  

Семплер (sampler) – електронний музичний інструмент, що дозволяє 

записувати, редагувати і відтворювати звуки. Його відмінність від інших 

електромузичних інструментів (ЕМІ), наприклад, синтезаторів, полягає в 

тому, що замість осциляторів (генераторів хвиль) використовується запи-

саний в пам'ять семпл (оцифрований звук), який розкладається по MIDI-

клавіатурі (Musical Instrument Digital Interface), змінюючи висоту тону до 

заданих умов. На даний час існує безліч таких пристроїв і їх віртуальних 
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аналогів. Часто семплер є опцією або основою електронних музичних ін-

струментів. 

Вихід в середині–кінці 1980-х років загальнодоступних цифрових сем-

плерів стимулював появу нових музичних напрямків, в першу чергу хіп-

хоп, acid house, драм-н-бейс. 

  

Домашнє завдання 

 

1. Вивчити теоретичний матеріал до роботи, методику виконання 

окремих пунктів роботи. 

2. З яких основних компонентів складається звукова система сучасного 

комп'ютера? Назвіть функції, виконувані ними. 

3. Дайте коротку характеристику основних типів та форматів звукових 

файлів. 

4. Назвіть і наведіть короткий опис основних ефектів і прийомів, засто-

совуваних при обробці звукових файлів в професійних редакторах. 

 

Лабораторне обладнання 

 

1. Персональний комп'ютер, укомплектований звуковою картою. 

2. Програма комп’ютерної обробки звуку Sound Forge. 

 

Порядок виконання  роботи  

 

1. Проведіть запис фонограми з джерела (музичний компакт-диск на 

лінійний вхід звукової карти або з мікрофона), зазначеного викладачем. 

Тривалість фонограми повинна бути не меншою 2–3 хвилин. 

2. Виконайте редагування записаної фонограми за допомогою редакто-

ра Sound Forge 4.5h. Необхідно домогтися помітного поліпшення якості 

звучання фонограми відносно вихідної. Особливу увагу слід приділити 

зниженню рівня спотворень і шумових складових, усуненню помітних ім-

пульсних перешкод, балансуванню стереоканалів. Застосовуючи різні ефе-

кти, постарайтеся домогтися більш природного і насиченого звучання. Не 

видаляючи вихідну фонограму, збережіть отриманий результат у файлі 

формату WAV. 

3. За допомогою програми Sound Forge 4.5h виконайте кодування ство-

реного при виконанні п. 2 WAV-файлу в формат MP3 з різними парамет-

рами стиснення. Варіюючи бітрейт від мінімального до максимального 

значення, зробіть висновок про те, які параметри компресії, на ваш погляд, 

можуть бути рекомендовані для даної фонограми і наявного апаратного 

забезпечення. Прослуховування MP3-файлів здійсніть за допомогою про-

грами Winamp, не змінюючи налаштування відтворення. 

 

 



53 

 

Методичні вказівки до виконання роботи 

 

Роботу з програмою зазвичай починають з її інтерфейсу.  

Доступ до всіх функцій програми можна отримати з головного меню, 

але для спрощення і прискорення роботи зручно використовувати лінійки 

інструментів, на яких розташовані кнопки з піктограмами. Натискання на 

кнопку еквівалентно вибору відповідної команди з головного меню. Ви-

кликаються лінійки інструментів з головного меню (Options> Preferences> 

Toolbars) (рис. 3.22). Відзначивши необхідні лінійки хрестиком, розмістіть 

їх по периметру вікна програми. 

  

 
 

Рисунок 3.22 − Інтерфейс програми Sound Forge 4.5h 

 

Далі виберіть драйвери вашої звукової плати для аудіозаписування та 

відтворення (Options > Preferences> Wave), а також для MIDI (MIDI-вхід і 

MIDI-вихід), якщо ви збираєтеся використовувати Sound Forge разом із зо-

внішніми MIDI-пристроями або іншими програмами, що підтримують 

MIDI (Options > Preferences> MIDI> Sync). 

Також можна встановити час попереднього перегляду різних звукових 

ефектів, які ви будете застосовувати (Options > Preferences> Previews). 

Можливість оцінити результат дії застосовуваного до звукового сигналу 

перетворення перед повною обробкою файлу значно заощадить час при 
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роботі з великими обсягами інформації. На практиці буває цілком достат-

ньо 5–10 секунд. 

На цьому закінчуються мінімальні налаштування. Для початку поста-

вимо перед собою просте завдання − записати звуковий фрагмент і провес-

ти його обробку за допомогою найбільш часто використовуваних ефектів. 

Відкриємо новий файл, виконавши команду File> New. При цьому 

з'явиться вікно з налаштуваннями режиму роботи, де можна обрати розря-

дність та частоту вибірки АЦП. 

 Контроль над записом, відтворенням і перемотуванням до початку та 

кінця файлу здійснюється керувальними кнопками, розташованими в пра-

вій верхній частині екрана, вони нагадують відповідні кнопки побутового 

рекордера. Для запису використовуємо мікрофон або будь-яке інше джере-

ло сигналу, наприклад, КД-програвач, підключений до входу звукової пла-

ти. Рівень вхідного сигналу можна регулювати програмно за допомогою 

мікшера, вбудованого в Sound Forge (View> Mixer), стандартного регуля-

тора рівня Windows або регулятора, що постачається в комплекті із звуко-

вою платою. 

Далі натискаємо на кнопку запису Record (Special> Transport> Record) і 

активізуємо допоміжне меню (рис. 3.23). 

У цьому меню вибирається: 

− формат файлу Mono/Stereo, Sample Size (розрядність), Sample Rate   

(частота дискретизації); 

− режим запису (заміна попереднього дубля наступним, послідовний 

запис дублів). 

Тут же знаходяться і індикатори рівня вхідного сигналу. 

Щоб почати записування, достатньо натиснути кнопку Record. Для 

припинення записування натисніть кнопку Stop, що з'явилася на місці кно-

пки Play. Потім закрийте допоміжне меню (кнопка Close) і приступайте до 

редагування записаної фонограми. 

Спочатку необхідно видалити свідомо зайві паузи на початку і в кінці 

файлу, що з'явилися в результаті затримки між моментом натиснення кно-

пок Record/Stop і початком/закінченням записування. Для цього потрібно 

відзначити необхідну для видалення область файлу і виконати команду 

Edit> Clear (або натиснути кнопку Delete на клавіатурі). Області файлу від-

значаються дуже просто: ставите мишу в вибране місце на екрані і рухаєте 

її вправо або вліво, попередньо натиснувши ліву кнопку, потім відпускаєте 

кнопку. Зазначена область забарвлюється в чорний колір. Зауважте, що 

якщо ви працюєте зі стереофайлом і хочете відзначити обидва канали від-

разу, то курсор потрібно ставити недалеко від горизонтальної лінії, що ро-

зділяє стереоканали. Якщо ж вам потрібно відзначити область тільки на 

одному з каналів, то курсор ставте нижче середнього рівня правого каналу 

або вище середнього рівня лівого. 
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Рисунок 3.23 − Допоміжне меню 

 

Якщо паузу перед початком файлу потрібно залишити, слід позбутися 

всіх шумів, присутніх у паузі, виконавши команду Process> Mute. 

Якщо сигнал слабо змінюється за гучністю (наприклад, якщо це звук 

електрогітари з ефектом Distortion), то корисно злегка обмежити його за 

рівнем для того, щоб уникнути можливих спотворень в процесі подальших 

перетворень. Для цього можна виконати команду Effects> Dinamics> 

Graphic і у вікні (рис. 3.24) скорегувати динамічну характеристику сигна-

лу. 

Наступною корисною і часто застосовуваною процедурою є обробка 

звуку еквалайзером, що дозволяє додати звуку бажане темброве забарв-

лення. У Sound Forge є три основних типи еквалайзера: графічний    

(Process> EQ> Graphic), параметричний (Process> EQ> Parametric) і комбі-

нований (Process> EQ> Paragraphic). Параметричний і комбінований еква-

лайзери дозволяють підсилити або приглушити обрану смугу частот, гра-

фічний же десятисмуговий еквалайзер дає більш гнучкий контроль над 

звуком, він поданий у вигляді панелі звичайного аналогового еквалайзера  

(рис. 3.25). 
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Рисунок 3.24 − Меню Effects> Dynamics 

 

 
 

Рисунок 3.25 − Вікно графічного еквалайзера 

Додати звуку нових фарб і відтінків можна, застосувавши ефект під на-

звою Chorus (хорус). Chorus створює враження, що звучать два або декіль-

ка джерел сигналу одночасно. Це досягається шляхом додавання до вихід-
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ного необробленого сигналу його копії, затриманої в часі до 100 мілісе-

кунд і зміненої за висотою. Для активізації хоруса виконайте команду 

Effects> Chorus і в меню виберіть яку-небудь попередню настанову або ре-

гулюйте параметри самостійно, змінюючи Input gain (рівень сигналу на 

вході), Dry out (рівень необробленого сигналу на виході), Chorus out            

(рівень обробленого сигналу на виході), Delay (затримка обробленого сиг-

налу відносно вихідного), Modulation Rate (частота модулювання оброб-

люваного сигналу), Modulation Depth (глибина модуляції), Feedback  (у від-

сотках вказується, яка частина обробленого сигналу піддається повторній 

обробці), Chorus size (кількість обробок вихідного сигналу ефектом). Пе-

ред тим, як застосувати ефект до всього файлу, можна попередньо оцінити 

його дію, натиснувши у допоміжному меню кнопку Preview. 

Найбільш вживаним звуковим ефектом, є реверберація (reverberation). 

Вона використовується для додання звуку "об'єму" і для імітації акустич-

них умов різних типів приміщень (концертний зал, хол, невелика кімната і 

т. д.). Практично жодний сучасний музичний запис не обходиться без ви-

користання реверберації. Ефект реверберації оснований на затримці копій 

вихідного сигналу в часі. Sound Forge дозволяє працювати з вісьмома копі-

ями, для кожної з яких можна незалежно задавати час затримки, амплітуду 

та розміщення в стереосигналі. Затримана в часі копія імітує перше відбит-

тя звукової хвилі від стіни уявного приміщення і піддається повторному 

перетворенню з параметрами Feedback, Modulation Rate, Modulation Depth і 

Lowpass ( фільтр високих частот ). Для виклику ефекту необхідно виконати 

команду Effects> Reverb, вибрати відповідну попередню настанову або за-

йнятися регулюваннями самостійно. 

Такий ефект як Delay/Echo (Затримка–Ехо) викликається командою 

Effects> Delay/Echo. Delay дозволяє імітувати відлуння і створює вражен-

ня, що звук лунає у великому приміщенні, в горах або ж, навпаки, в над-

звичайно маленькій кімнаті.  

Слід зазначити, що три описаних вище ефекти ( Chorus, Reverb, Delay/ 

Echo ) є спорідненими, в їх основу покладено принцип затримки однієї або 

декількох копій вихідного сигналу в часі. Тому застосовувати всі ці ефекти 

відразу до одного звукового файлу далеко не завжди доцільно. Часто ви-

стачає або одного з них, або поєднання двох, наприклад, Chorus> Reverb. 

Звук не повинен в підсумку виявитися забитим численними відлуннями і 

незрозумілими шумами.  

За допомогою наявних в Sound Forge засобів обробки можна легко реа-

лізувати ефект поступового наростання гучності звучання на початку фай-

лу або загасання гучності в його кінці. Достатньо лише виділити необхідну 

область звукової хвилі і виконати Process> Fade> In для отримання ефекту 

наростання гучності або Process> Fade> Out для її загасання. Зміни амплі-

туди сигналу протягом усього файлу можна задавати і графічно (Process> 

Fade> Graphic). Графічне подання дуже наочне і надає повну свободу твор-

чості. 
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Описані вище звукові ефекти використовуються при обробці мало не 

кожного звукового файлу. Крім них, Sound Forge пропонує і безліч інших, 

які також дуже цікаві, але використовуються рідше. Це такі специфічні 

ефекти, як Reverse (Process> Reverse), що дозволяє відтворити звуковий 

фрагмент задом наперед; Pitch Bend (Effects> Pitch> Bend), який змінює 

висоту звуку відповідно до заданої обвідної; Gapper/Snipper (Effects> 

Gapper> Snipper) − з його допомогою можна, наприклад, надати голосу 

людини механічних відтінків; Amplitude Modulation (амплітудна модуляція 

− Effects> Amplitude Modulation), який дозволяє домогтися як тремоло, так 

і незвичайних спотворень звуку; Distortion (Effects> Distortion) − імітує пе-

ревантаження підсилювача і т. д. 

Корисною є можливість прискорювати або сповільнювати звуковий 

фрагмент, не змінюючи при цьому його висоту (Process> Time Compress/ 

Expand). Діапазон стиснення/розтягування не дуже широкий: прискорюва-

ти фонограму можна в два рази, а сповільнювати всього в півтора.  

Ще один корисний ефект − це Noise Gate (Effects> Noise Gate). Він до-

зволяє позбутися усіх шумів, присутніх в паузах, коли основний сигнал 

тимчасово відсутній. Суть ефекту в тому, що він прибирає всі звуки і шу-

ми, амплітуда яких нижча заданого рівня. 

Звук, який в подальшому планується завантажувати в семплер, пови-

нен мати максимально можливу амплітуду, яка не викликає спотворення. 

Для цього використовується операція нормалізації (Process> Normalize). 

Зверніть увагу, що майже всі ефекти можна застосовувати не тільки до 

обох каналів відразу, але і до одного з них окремо. Обробка звукового 

файлу одним і тим же ефектом, які мають на правому та лівому каналах 

різні установки, часто дає дуже цікавий результат. Особливо це відносить-

ся до затримки і реверберації. Ефекти, застосовані до лівого каналу, мо-

жуть зовсім відрізнятися від ефектів, застосованих до правого. Єдине об-

меження − фантазія. Не бійтеся експериментувати. Помітний вплив на кін-

цевий результат робить і порядок обробки файлу певним набором ефектів. 

Спробуйте різні варіанти (наприклад, EQ-Chorus-Delay або Chorus-Delay-

EQ і т. п.). 

 

Контрольні запитання 

 

1. Що таке аналого-цифрові і цифро-аналогові перетворювачі звуково-

го сигналу? 

2. Якими параметрами характеризується аудіосигнал, перетворений у 

цифрову форму? 

3. Як залежить динамічний діапазон і рівень шуму від параметрів оци-

фровування звукового сигналу? 

4. Які основні принципи стиснення аудіоданих використовуються в 

MP3-алгоритмах? 
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5. Що таке бітрейт? Як розрахувати бітрейт для нестисненого сигналу, 

якщо відомі параметри його оцифровування? 

6. Назвіть основні найбільш поширені операції над звуком, які виконує 

редактор Sound Forge. 

 

 

3.7 Лабораторна робота № 7 "Визначення основних параметрів 

пристрою запису мовного сигналу" 
 

Мета роботи – ознайомитись з принципами прямого перетворення з 

аналогової форми в цифрову і оберненого перетворення із цифрової форми 

в аналогову мовного сигналу; експериментально зняти параметри при-

строю запису та відтворення. 

 

Стислі теоретичні відомості 

 

В основі будь-якого перетворення та зберігання аналогового сигналу в 

цифровому вигляді є перетворення його за допомогою АЦП в двійкову по-

слідовність (вибірки (sampled data)).  

Період отримання вибірок розраховується за теоремою Котельникова, 

тобто частота вибірок або частота дискретизації потрібна бути, як мінімум, 

в два рази вищою за максимальну частоту сигналу, який перетворюється в 

цифровий вигляд. Таким чином, для того, щоб перетворити в цифровий 

код мовний сигнал із спектром в смузі 300–3400 Гц (телефонний канал) 

треба отримувати послідовність цифрових кодів з частотою дискретизації 

6,8 кГц. Для оцифровування мовного сигналу зі смугою пропускання те-

лефонного каналу найчастіше використовується частота дискретизації       

8 кГц.   

Після оцифровування аналогового сигналу з виходу  АЦП отримується   

імпульсно-кодово модульований сигнал (pulse code modulated signal, ІКМ-

сигнал), який поступає на вхід мікроконтролера (рис. 3.26). В мікроконт-

ролері відбувається програмне стиснення цифрової інформації. Завдяки 

стисненню досягається досить ефективне використання flash-пам’яті, де 

зберігається записана інформація. Способів і алгоритмів стиснення є бага-

то: LPC − Linear Predictive Coding, CELP − Code-Excited Linear Prediction, 

CS-ACELP − Conjugate-Structured Algebraic CELP та багато інших [10, 23, 

25].  

В даній лабораторній роботі використовується так званий спосіб адап-

тивної диференційної імпульсно-кодової модуляції (ADPCM − Adaptive 

Differential Pulse Code Modulation) [23, 24]. Це досить поширений спосіб, 

який дозволяє стискати 16-бітовий код в 4-бітовий з досить непоганою які-

стю (і навіть в три-, дво- та однобітовий код, але якість відтворюваного си-

гналу різко погіршується). В основі методу ADPCM є та властивість, що 

значення сусідніх відліків (sampling) різняться між собою на невелике зна-



60 

 

чення. Тому замість обробки самих відліків відбувається обробка різниці 

між сусідніми відліками.  

Для декодування сигналу треба знати тільки значення першого відліку 

в даному блоці. Далі, знаючи різницю між даним відліком і наступним, ви-

раховується значення наступного відліку. На наступному кроці базовим 

вже є вирахуваний відлік і за його значенням знаходиться значення насту-

пного. Таким чином в даному методі кодування для визначення відліку 

треба обов’язково знати значення попереднього [24]. 
            

            

            

            

            

            

            

            

            

            

       

Рисунок 3.26 – Спрощена структурна схема пристрою записування,        

відтворення та зберігання аналогового сигналу в цифровому вигляді 

 

Після кодування цифрова послідовність зберігається у пам'яті або пе-

редається по каналу зв'язку. Для того, щоб отримати аналоговий сигнал, 

кодова послідовність декодується мікроконтролером, в результаті чого на 

виході пристрою відтворюється досить точно сигнал-оригінал. Для перет-

ворення ІКМ-сигналу в аналоговий вигляд використовується ЦАП. На вхід 

ЦАП з частотою дискретизації подається ІКМ-послідовність, вихідна на-

пруга ЦАП підсилюється і подається на гучномовець [10, 15]. 

 

Опис лабораторної установки 

 

Схема лабораторної установки наведена на рис. 3.27. 

Основою лабораторного макету є мікросхема фірми Motorola 

МС145483, яка є 13-бітовим ІКМ кодеком ( [ко]дером –  [дек]одером ) – 

фільтром. В мікросхемі (рис. 3.28) є вхідні та вихідні операційні підсилю-

вачі, вхідні та вихідні ФНЧ, вбудовані 13-бітові АЦП та ЦАП. Дані пере-

даються по трипроводовому SPI-інтерфейсу (інтерфейс послідовної пере-

дачі даних, де по одній лінії передаються тактові імпульси, а по двох ін-

ших – дані передачі та прийому). 
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Рисунок 3.27 – Схема лабораторної установки 
 

 
 

Рисунок 3.28 – Функціональна схема мікросхеми кодека МС145483 
 

Призначення виводів:  

Vdd – позитивна напруга живлення; 

Vss – негативна напруга живлення; 

Vag – нижня межа напруги для АЦП та ЦАП; 

Vagref – "аналогова земля"; 

HB – вхід включення фільтра на 200 Гц; 

PDI – логічний нуль на цьому вході переводить мікросхему в сплячий 

режим; 

TI+ – неінвертувальний аналоговий вхід; 

TI- – інвертувальний аналоговий вхід; 
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TG – вхід вибору коефіцієнта підсилення; 

RO- – аналоговий вихід; 

PI – вхід підсилювача потужності; 

PO- – вихід підсилювача потужності (інвертувальний); 

PO+ – вихід підсилювача потужності (неінвертувальний); 

MCLK – вхід тактової частоти (SPI – інтерфейс); 

FST – вхід частоти 8 кГц для синхронізації даних, що передаються; 

BCLKT – контроль швидкості передавання ІКМ-даних; 

DT – вихід регістра зсуву передавача (SPI – інтерфейс); 

FSR – вхід частоти 8 кГц для синхронізації даних, що приймаються; 

BCLKR –  контроль швидкості приймання ІКМ-даних; 

DR – вхід регістра зсуву приймача (SPI – інтерфейс); 

ПрРЗ – приймальний регістр зсуву;  

ПРЗ – передавальний регістр зсуву.  

 

Повна схема лабораторного макета наведена на рис. 3.29. Схема керу-

вання складена на мікроконтролері фірми Microchip PIC16F76. Інформація 

зберігається в енергонезалежній пам’яті фірми Atmel AT45DB161 обсягом 

16 Мбіт, чого при даному алгоритмі стискання достатньо для зберігання до 

15 хвилин мовного сигналу. 

Стисло роботу макета (рис. 3.29) можна описати таким чином: мікро-

контролер РІС16F876 працює від RC-генератора, оскільки для керування 

пам'яттю, світлодіодами та кнопками особливої точності часових інтерва-

лів не потребується. Вбудований в мікроконтролер таймер-лічильник має 

свій тактовий генератор на 32 кГц. Це зроблено для генерування, шляхом 

поділу тактової частоти на чотири, опорної частоти 8 кГц з метою прави-

льного функціонування мікросхеми кодека. В схемі присутні дві кнопки та 

два світлодіоди, які пов’язані між собою. Їх призначення – індикація та 

ініціалізація режиму, в якому зараз знаходиться лабораторний макет (ре-

жим записування чи режим відтворення). Живлення макета здійснюється 

від лабораторного джерела живлення 12 В, в схемі після стабілізатора 

отримується напруга 3 В для живлення мікроконтролера, кодека та пам’яті. 

В схемі є можливість з'єднання з комп'ютером по інтерфейсу RS-232 (com-

порт). Цей же роз'єм використовується для підключення гучномовця. Мік-

росхема кодека підключена за рекомендованим виробником включенням. 

Використана мікросхема пам’яті з паралельним інтерфейсом. Записування, 

читання та керування виконується за допомогою мікроконтролера.  

 

Домашнє завдання 

 

1. Опрацювати лекційний матеріал по даній темі. 

2. Ознайомитись зі схемами лабораторної установки і лабораторного 

макета, методикою експериментальних досліджень. 
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3. Вивчити схемотехніку апаратури цифрового звукозапису на ком-

пакт-диск, жорсткий диск, флеш-пам'ять та ін. 

 

Вимірювальна апаратура і апаратура, яка досліджується 

 

1. Лабораторний макет. 

2. Лабораторне джерело живлення ТЕС-88. 

3. Генератор низькочастотний ГЗ-118. 

4. Мілівольтметр В3-38. 

5. Частотомір ЧЗ-54. 

6. Осцилограф С1-83. 

7. Вимірювач нелінійних спотворень С6-5. 

8. Смуговий фільтр 200-3400 Гц. 

 

Програма експериментальних досліджень 

 

1. Зібрати лабораторну установку та перевірити її роботоздатність. 

2. Здійснити запис гармонічного сигналу з частотою 1000 Гц. 

3. Дослідити за допомогою осцилографа напруги в контрольних       

точках, відтворюючи записаний сигнал. Зарисувати форму сигналів та за-

писати їх параметри. 

4. Визначити відношення сигнал/шум D. 

5. Зняти АЧХ пристрою в стандартних умовах на частотах, вказаних в 

методичних вказівках до лабораторної роботи. 

6. Визначити гармонічні спотворення в номінальних умовах. На вхід 

пристрою подати синусоїдальний сигнал з частотою 315, 1000 та 3400 Гц. 

7. Здійснити запис мовного сигналу (голос студента) протягом         

декількох хвилин та дати суб'єктивну оцінку якості запису. 

8. Зробити висновки по всіх пунктах досліджень. 

 

Методичні вказівки до проведення експериментальних досліджень 

 

1. Записування гармонічного сигналу з частотою 1000 Гц виконується 

за допомогою генератора низької частоти. Записування проводиться в    

номінальних умовах. Для даного пристрою номінальними умовами є      

напруга на вході   5 мВ. Стандартні умови  – умови, при яких напруга на 

вході менша напруги номінальної умови на 10 дБ (менша в 3,16 раза). Для 

записування до входу макета приєднують генератор, виставляють частоту 

1000 Гц, тумблер "Мікрофон-Генератор" встановлюють в положення     

"Генератор". Записування виконується натисканням кнопки "Запис" із    

загоранням відповідного світлодіода. 
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2. Контрольні точки розставлені в таких частинах схеми:  

КТ1 – видача з мікроконтролера частоти дискретизації 8 кГц для     си-

нхронізації перетворення;  

КТ2 – вихід кодека, тут можна побачити записаний сигнал в аналоговій 

формі; 

КТ3 – тактовий сигнал для передачі даних по SPI-інтерфейсу; 

КТ4, КТ5 – дані, які відповідно передаються та приймаються              

мікросхемою кодека при перетворенні сигналів. 

3. Відношення сигнал/шум. 

Встановити макет в номінальні умови. Записати гармонічний сигнал з 

частотою 1000 Гц протягом 2–3 хв. Потім відключити генератор і вхід   

замкнути на еквівалент джерела. Напругу шуму Uш виміряти через        

смуговий фільтр, який пропускає тільки звукові частоти і корегувати при 

значенні послаблення фільтра    ф     на частоті    1000    Гц.   В    результаті  

відношення сигнал/шум розраховувати за формулою: 

 

фШ

H

U

U
D


 lg20 . 

 

4. Зняти в стандартних умовах АЧХ, вимірюючи напругу на виході 

макету на частотах  200, 315, 500, 600, 800, 1000, 1200, 1500, 1700, 2000, 

2200, 2500, 2700, 3000, 3200 та 3400 Гц. Дані занести в таблицю та побуду-

вати графік АЧХ. 

5. Гармонічні спотворення. 

Встановити номінальні умови. Пункт виконується з застосуванням ви-

мірювача нелінійних спотворень С6-5. Проводиться протягом 2–3 хвилин 

записування сигналу з генератора низької частоти (тумблер "Мікрофон-

Генератор" в положенні "Генератор"). Після закінчення включити макет на 

відтворення (кнопка "Відтворення", індикація відповідним світлодіодом) 

та провести відповідні вимірювання на частоті 315, 1000 та 3400 Гц. 

 

Контрольні запитання 

 

1. Поясніть принцип записування та зберігання аналогового сигналу в 

цифровому вигляді. 

2. Які існують методи підвищення ефективності використання оциф-

рованих даних? 

3. Якою є методика експериментального визначення основних пара-

метрів пристрою записування та відтворення аналогового мовного сигналу 

в цифровому вигляді? 
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4. В чому недоліки та переваги записування мовного сигналу в флеш-

пам'ять порівняно з цифровим записуванням на магнітну стрічку чи ком-

пакт-диск? 

5. Які ще ви знаєте методи стискання мовного сигналу крім тих, що 

наведені в роботі? 
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СЛОВНИК НАЙБІЛЬШ ВЖИВАНИХ ТЕРМІНІВ 

 

Автокореляція – autocorrelation 

Автокореляційна функція – autocorrelation function 

Адаптивна диференційна імпульсно-кодова модуляція (ДІКМ) – 

adaptive differential pulse code modulation 

Амплітудно-фазова маніпуляція – amplitude-phase manipulation 

Аналогово-цифровий перетворювач (АЦП) – analog to digital converter      

Вибірки – sampled data                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 

Високочастотна фільтрація – high-frequency filtration 

Відліки – sampling 

Відносна фазова маніпуляція (ВФМ) – the phase manipulation 

Відношення сигнал-шум – signal to noise ratio 

Децимація – decimation 

Динамічний діапазон – dynamic range 

Дискретизація – discretization  

Діапазон відтворюваних частот – replay frequency range 

Обернене дискретне перетворення Фур’є – inverse discrete Fourier 

transform 

Обернене перетворення Фур’є – inverse Fourier transform 

Імпульсно-кодовомодульований сигнал (ІКМ) – pulse code modulated 

signal 

Інтерполяція – interpolation 

Квантування – quantization 

Квадратурно-амплітудна маніпуляція (КАМ) – quadrature-amplitude 

manipulation 

КД програвач – CD player 

Коефіцієнт детонації – wow and flutter, flutter rate 

Коефіцієнт нелінійних спотворень – non-linear distortion ratio  

Лінійна фільтрація – linear filtering  

Математичне сподівання – mathematical expectation 

Медіанна фільтрація – median filtration 
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Мікроконтролер – microcontroller 

Нерівномірне квантування – non-uniform quantization  

Низькочастотна фільтрація – low-frequency filtration 

Передатна функція – the transfer function 

Перемножувач – multiplier  

Промінь лазера – the laser beam 

Потужність  випромінювання – radiation power 

Пряме дискретне перетворення Фур'є (ДПФ) – direct discrete Fourier 

transform 

Пряме перетворення Фур'є – direct Fourier transform 

Реверберація – reverberation 

Рівні квантування – quantization levels  

Рівномірне квантування – uniform quantization  

Розділення каналів – the separation channels  

Розрядність квантування – number of bits 

Семплер – sampler  

Середньоквадратичне відхилення – root mean square 

Система автофокусування – system of automatic focusing 

Спектральний аналіз – spectral analysis 

Спектральна щільність сигналу – signal spectral destiny  

Спектральна ефективність – spectral efficiency 

Фрейм – frame 

Цифро-аналоговий перетворювач (ЦАП) –  digital to analog converter           

Цифрова маніпуляція – digital manipulation                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                        

Цифрове кодування аудіо-, відеосигналів – digital encoding of audio- and 

video signals 

Цифрове радіомовлення – digital broadcasting 

Цифрове телебачення DVB – digital video broadcasting 

Цифровий фільтр – digital filter 

Частота дискретизації – sampling frequency 

Швидке перетворення Фур'є (ШПФ) – fast Fourier transform 
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